<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional) Creating Static IP Hosts</td>
<td>42</td>
</tr>
<tr>
<td>Configuring an ATM Uplink</td>
<td>44</td>
</tr>
<tr>
<td>Configuring an OCn Optical Uplink</td>
<td>45</td>
</tr>
<tr>
<td>Configuring a DS3 Uplink</td>
<td>47</td>
</tr>
<tr>
<td>Configuring an IMA Uplink</td>
<td>48</td>
</tr>
<tr>
<td>Configuring a T1 UNI Uplink</td>
<td>51</td>
</tr>
<tr>
<td>Chapter 4: Configure Subscriber Connections</td>
<td>53</td>
</tr>
<tr>
<td>Creating Subscriber Connections</td>
<td>54</td>
</tr>
<tr>
<td>Adding New Subscriber Connections</td>
<td>54</td>
</tr>
<tr>
<td>Reconfiguring Subscriber Connections</td>
<td>56</td>
</tr>
<tr>
<td>Activating Service</td>
<td>58</td>
</tr>
<tr>
<td>Placing Subscriber Ports Into Service</td>
<td>58</td>
</tr>
<tr>
<td>Configuration Complete</td>
<td>59</td>
</tr>
<tr>
<td>Chapter 5: Troubleshooting and Maintenance</td>
<td>61</td>
</tr>
<tr>
<td>Troubleshooting Common Broadband Internet Service Issues</td>
<td>62</td>
</tr>
<tr>
<td>Using the Ethernet Uplink Troubleshooting Utilities</td>
<td>63</td>
</tr>
<tr>
<td>Ping IP Hosts</td>
<td>63</td>
</tr>
<tr>
<td>Trace Routes to IP Hosts</td>
<td>65</td>
</tr>
<tr>
<td>DHCP Lease Maintenance</td>
<td>66</td>
</tr>
<tr>
<td>Modify ARP Settings</td>
<td>67</td>
</tr>
<tr>
<td>Configuring xDSL Power Management</td>
<td>68</td>
</tr>
<tr>
<td>About xDSL Power Management</td>
<td>68</td>
</tr>
<tr>
<td>Configuring the xDSL Power Shutdown Priority</td>
<td>69</td>
</tr>
<tr>
<td>Setting the Category 3 Shutdown Timer</td>
<td>69</td>
</tr>
<tr>
<td>Modifying Subscriber Connections</td>
<td>70</td>
</tr>
<tr>
<td>Deleting Subscriber Connections</td>
<td>70</td>
</tr>
<tr>
<td>Rebuilding Subscriber Cross-Connects</td>
<td>71</td>
</tr>
<tr>
<td>Viewing PPPoE Data for Ethernet Uplinks</td>
<td>73</td>
</tr>
<tr>
<td>PPPoE Access Concentrator</td>
<td>73</td>
</tr>
<tr>
<td>PPPoE Host</td>
<td>74</td>
</tr>
<tr>
<td>PPPoE Session</td>
<td>74</td>
</tr>
<tr>
<td>PPPoE Stats</td>
<td>75</td>
</tr>
<tr>
<td>PPPoE AC Stats</td>
<td>76</td>
</tr>
</tbody>
</table>
Chapter 6: Quick Internet Service Turn-Up..........................79

Turning Up ADSL Internet Service (Ethernet Uplink) ...........................................80
  Quick Turn-Up Process...................................................................................80

Turning Up ADSL Internet Service (ATM Uplink) ..................................................82
  Quick Turn-Up Process...................................................................................83

Turning Up ONT Internet Service (Ethernet Uplink) .............................................85
  Quick Turn-Up Process...................................................................................85

Turning Up ONT Internet Service (ATM Uplink) ....................................................87
  Quick Turn-Up Process...................................................................................88
Chapter 1

Overview of C7 Broadband Internet Services

About This Guide

The Calix C7 multiservice access platform supports broadband Internet service applications over copper-based (DSL) and fiber-based (PON) access networks. This document describes how to configure broadband Internet services on the Calix C7.

Intended Audience

The primary audience for the Calix C7 Broadband Internet Services Guide includes personnel responsible for service configuration at the Central Office (CO) or Network Operations Center (NOC). Calix assumes that readers of this guide have experience with computer systems and software and knowledge of telecommunications and engineering standards. Familiarity with C7 system hardware and the Calix C7 iMS interface is recommended.
Related Documentation

You can access the complete set of Calix C7 installation, configuration, product, and support documentation, as well as online training courses, at the Calix Customer Center, accessible online at http://www.calix.com.

The Calix C7 Release 5.0 documentation set includes:

- *Calix C7 Engineering and Planning Guide*
- *Calix Upgrade Program (CUP) Application Guide*
- *Calix C7 iMS Guide*
- *Calix C7 Troubleshooting and Maintenance Guide*
- *Calix C7 Broadband Internet Services Guide*
- *Calix C7 Video Services Guide*
- *Calix C7 FTTP Configuration Guide*
- *Calix C7 H.248 Media Gateway Configuration Guide*
- *TL1 Management Interface Reference*
- *SNMP MIBs*

**Introduction**

This chapter covers the following topics:

- A brief introduction to the Calix C7 broadband Internet service applications.
- An overview of the configuration process for turning up broadband Internet services.
About C7 Broadband Internet Services

The Calix C7 supports broadband Internet service applications over copper-based (DSL) and fiber-based (PON) access networks. Broadband Internet services can be deployed from any C7 node. That is, the plug-in cards providing broadband subscriber access (ADSL or OLTB-2) can reside in either the Central Office or in Remote Terminals.

The C7 supports Ethernet and ATM trunk interface types to uplink Internet traffic to the WAN. In addition, C7 Ethernet uplinks support static routing, Routed Bridged Encapsulation, DHCP Relay with Option 82, and PPPoE Relay for broadband Internet subscribers.
**Configuration Overview**

This section provides a general information about configuring broadband Internet services on the Calix C7, including supported equipment, configuration guidelines, and an overview of the configuration process.

**Supported Equipment**

The Calix C7 supports broadband Internet service applications using the C7 plug-in cards and related equipment listed below.

**Supported Access**

The C7 supports DSL and PON/FTTP access options for Internet service.

- **C7 DSL Access:** The C7 supports ADSL2+ and legacy ADSL access ports using the following C7 plug-in cards:
  - ADSL2-24, ADSL-24
  - COMBO2-24, COMBO2-24D, COMBO-24

- **DSL Customer Premises Equipment (CPE):** The C7 supports interoperability with standards-based ADSL2+/ADSL modems.

- **C7 PON/FTTP Access:** The C7 supports Passive Optical Networks (PONs) for Fiber-to-the-Premises (FTTP) applications using the OLTB-2 plug-in card, which is equipped with two BPON ports. Each BPON port can support up to 32 standards-based BPON Optical Network Terminals (ONTs).

- **PON/FTTP Customer Premises Equipment (CPE):** The C7 supports interoperability with the Calix 700-Series ONTs as well as other standards-based BPON ONTs. To support Internet services, the ONT must be equipped with one or more 10/100 Ethernet port.

**Supported Uplinks**

The C7 supports Ethernet and ATM uplink types for Internet service.

- **C7 Ethernet Uplinks:** The C7 supports Ethernet uplinks using the GE-2p or GE-2p/FE-4p plug-in cards, which are equipped with two Gigabit Ethernet (GE) ports and four 10/100 Fast Ethernet (FE) ports. The GE-2p and GE-2p/FE-4p cards support static routing, Routed Bridged Encapsulation, DHCP Relay with Option 82, and PPPoE Relay.
C7 ATM Uplinks: The C7 supports several ATM uplink types, including OCn (OC3/12/48) optical, DS3, IMA and T1 UNI interfaces. You can use any of the following C7 plug-in cards to provide ATM uplinks:

- OC3-4, OC12-4, OC48-1
- RAP-OC3/12, RAP-OC3/12/48, RAP-OC48
- DS3-12p, DS3-4p, DS3E-4p
- T1-6 A+T (IMA or UNI mode)

Guidelines

This section provides general configuration guidelines for C7 broadband Internet service applications.

Configuration Guidelines

Follow these guidelines when configuring broadband Internet services on the Calix C7:

- Install the access/service cards (ADSL or OLTB-2) in any C7 node (CO or RT).
- Install ATM uplink cards in any C7 node (CO or RT).
- Install GE-2p/FE-4p uplink cards in any C7 node (CO or RT). Or install GE-2p uplink cards in any environmentally-controlled node. The GE-2p/FE-4p and GE-2p cards are functionally identical, except that the GE-2p/FE-4p card is industrially rated to support deployments in outdoor remote terminals.

Note: For simplicity, all subsequent references to "GE-2p" in this guide apply to both the GE-2p and GE-2p/FE-4p cards.

- The C7 supports redundant Internet uplinks only when using card types that support equipment protection.
- For Ethernet uplinks providing static routing support, all IP interfaces on the GE-2p uplink card must use IP addresses belonging to different subnets.
- When provisioning subscriber cross-connections, be careful not to exceed the number of connections supported by the uplink interface type. For cross-connect limits per interface type, refer to the Calix C7 Engineering and Guide.
- For PON/FTTP applications, the ONTs should be installed, wired, turned up and ranged before you configure broadband Internet services to the ONTs. You can pre-provision ONTs that are not yet in service from the C7 iMS; however, the procedures in this document assume the ONT to configure for Internet service is turned up and ranged.

Note: This document does not describe how to turn up ONTs for PON/FTTP applications, but rather, it describes how to turn up Internet services on ONT data (Ethernet) ports. For instructions to turn up an ONT, including how to create an apply an ONT profile from the C7 iMS, please refer to the Calix C7 FTTP Configuration Guide.
Information you need

You need to have the following information on-hand to configure broadband Internet service:

- ATM traffic profile requirements to create custom traffic profiles.
- ADSL service parameter requirements to create custom ADSL templates.
- VPI and VCI values used by the subscriber’s ADSL modem.
- (For Ethernet uplinks only) Typically at least two IP addresses for the GE-2p uplink card—one IP address for the physical Ethernet uplink interface and one or more IP addresses to define the subscriber subnet(s) for DHCP relay, if applicable. All IP addresses must belong to different subnets.
- (For Ethernet uplinks only) The IP address of the default gateway router.
- (For ATM uplinks only) VPI and VCI values for the uplink cross-connects, as provided by your Internet Service Provider (ISP).

Configuration Process

The high-level process for turning up broadband Internet service on the Calix C7 is described below.

Starting point

Before starting the configuration process, check that the following conditions are met:

- Transport is established to all C7 nodes providing broadband Internet service.
- The uplink card is installed and wired.
- The ADSL and/or OLTB-2 service cards are installed and wired.
- (PON/FTTP applications only) The ONTs are installed, wired, turned up and ranged.

Configuration Process Overview

The Calix C7 broadband Internet service configuration process follows:

1. Verify that all required equipment is installed and wired.
2. Configure profiles and templates.
   - Create ATM traffic profiles for subscriber cross-connects.
   - Create ADSL templates to define ADSL port settings (for ADSL subscriber ports only).
   - Create Subscriber Templates to define your different broadband Internet service offerings.
3. Configure the Internet uplink.
   • Configure the Ethernet or ATM interface port for uplink service.
   • Configure routing support on the uplink card (for Ethernet uplinks only).

4. Configure subscriber connections.
   • Apply Subscriber Templates to the access ports and create the cross-connections for subscriber service.
   • Place subscriber ports into service to activate Internet service.
Chapter 2

Configure Profiles and Templates

You can create global profiles and templates to simplify the bulk provisioning process for subscriber services. Creating profiles and templates allows you to define the characteristics of a common configuration element once, then reference or apply that profile or template multiple times throughout the network.

This chapter describes how to create profiles and templates associated with provisioning of broadband Internet services, including ATM traffic profiles to define subscriber cross-connection attributes, ADSL templates to define ADSL port settings, and Subscriber Templates to define your service offerings.

Tasks Covered

This chapter covers the following configuration tasks:

- Configuring ATM traffic profiles for subscriber Internet cross-connections.
- Configuring ADSL templates to define ADSL port settings and service attributes.
- Configuring Subscriber Templates to define your broadband Internet service offerings.

Note: This section does not describe how to create an ONT profile. ONT profiles are required to turn up and range ONTs for service, independent of any subscriber services provisioning on the ONT. As specified in the configuration guidelines (on page 11) for PON/FTTP applications, this guide assumes that you have already installed, wired, turned up and ranged all ONTs, so the ONTs should be equipped with profiles already. For instructions to turn up service on an ONT, including how to create an apply an ONT profile, please refer to the Calix C7 FTTP Configuration Guide.
Creating ATM Traffic Profiles

Create ATM traffic profiles to define the bandwidth attributes for subscriber cross-connections. You can create up to 500 custom traffic profiles, or you can use any of the default traffic profiles provided by the C7.

About UBR and UBR+ Profiles

Traffic profiles for Internet cross-connects typically use the UBR or UBR+ classes of service. Common applications for the UBR and UBR+ classes of service follow:

- **UBR** (unspecified bit rate): For non-real-time applications that have no performance requirements (such as Internet connections).
- **UBR+** (unspecified bit rate plus): For non-real-time applications that require minimum bandwidth reserved on a link (such as higher-speed Internet connections of premium services).

For broadband Internet services in PON/FTTP applications, Calix recommends creating a custom UBR+ profile for the data cross-connection to the ONT Ethernet port, so as to provide minimum and maximum bandwidth.

UBR and UBR+ Parameter Descriptions

Select the UBR class of service for most Internet applications to provide a "best effort" transmission rate. For UBR profiles, simply specify a Peak Cell Rate (PCR) to limit traffic to a maximum rate, so as to keep high-volume users from using up all available bandwidth. Select the UBR+ class of service for Internet applications for which you want to also reserve minimum bandwidth on the link. To reserve the minimum bandwidth, you specify a Minimum Cell Rate (MCR) in addition to the PCR, to help ensure that all subscribers have satisfactory bandwidth.

**Note:** If you do not set values for MCR and PCR when using UBR+, the profile behaves like UBR, the minimum cell rate defaults to zero and the peak cell rate defaults to the line rate.

**Peak Cell Rate (PCR01)** Identifies the fastest rate at which cells from the same ATM connection arrive. The rate is expressed in cells per second (cps). This parameter is applicable for all the supported classes of service. PCR is an integer greater than 0.

**Minimum Cell Rate (MCR)** Specifies a guaranteed minimum cell rate that the connection will support. The rate is specified in cells per second (cps). This parameter is applicable only to the GFR and UBR+ class of service. MCR is an integer and must be less than PCR01.
Default UBR Traffic Profile

The C7 provides one default UBR profile. The following table shows the attributes of the default C7 UBR profile.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Identifier (ID)</td>
<td>UBR</td>
</tr>
<tr>
<td>Description (DESC)</td>
<td>UBR</td>
</tr>
<tr>
<td>Class of Service (COS)</td>
<td>UBR</td>
</tr>
<tr>
<td>Cell Delay Variation Tolerance (CDVT)</td>
<td>40 (µs)</td>
</tr>
<tr>
<td>Peak Cell Rate (PCR01)</td>
<td>2830 (cps)</td>
</tr>
<tr>
<td>Cell Tagging (CELLTAG)</td>
<td>N</td>
</tr>
<tr>
<td>Police (POLICE)</td>
<td>Y</td>
</tr>
<tr>
<td>Application ID (APPID)</td>
<td>(blank)</td>
</tr>
<tr>
<td>Active (ACTIVE)</td>
<td>Y</td>
</tr>
</tbody>
</table>

**Note:** The Peak Cell Rate is expressed in cells per second (cps). The default PCR value of 2830 cps equates to 1.2 Mbps.

Creating Custom UBR and UBR+ Traffic Profiles

You can create custom UBR or UBR+ traffic profiles to suit your service requirements. You may wish to create separate profiles for upstream and downstream traffic. If so, perform the following procedures twice, once to create an upstream profile and again to create a downstream profile.

**To create a UBR traffic profile**

1. On the File menu, click **Create > Network > Profiles > ATM Traffic Profile**.
2. In the ATM Traffic Profile dialog box, set the new profile parameters as follows:
   a. In the Profile Identifier box, type an ID number for the new traffic profile.
   b. In the Description box, type a brief name to describe this profile (up to 11 characters). For example, type **UBR DS**.
3. Define the attributes for ATM traffic profile:
   a. In the Class of Service list, click **UBR**.

   **Note:** The available traffic descriptors change according to the class of service selected.

   b. In the Peak Cell Rate box, type a PCR value (in cells per second).
      For example, to cap the traffic rate at 3 Mbps, type **7075**.

   **Note:** To convert units from Mbps to cps, click the calculator icon to the right of the Peak Cell Rate box. Enter a value in Mbps, then click **OK**. The iMS automatically converts the supplied value to cps units.

c. In the Application ID list, accept the default value (blank).

d. In the Active list, click **Y** (Yes) to enable this traffic profile.

4. Click **OK** to save the new profile.

---

**To create a UBR+ traffic profile**

1. On the File menu, click **Create > Network > Profiles > ATM Traffic Profile**.

2. In the ATM Traffic Profile dialog box, set the new profile parameters as follows:
   a. In the Profile Identifier box, type an ID number for the new traffic profile.
   b. In the Description box, type a brief name to describe this profile (up to 11 characters). For example, type **UBR+ DS**.

3. Define the attributes for ATM traffic profile:
   a. In the Class of Service list, click **UBR+**.

   **Note:** The available traffic descriptors change according to the class of service selected.

   b. In the Peak Cell Rate box, type a PCR value (in cells per second).
      For example, to cap the traffic rate at 6 Mbps, type **14150**.

   **Note:** To convert units from Mbps to cps, click the calculator icon to the right of the Peak Cell Rate box. Enter a value in Mbps, then click **OK**. The iMS automatically converts the supplied value to cps units.

c. In the Minimum Cell Rate box, type a MCR value (in cells per second).
   For example, to define a minimum traffic rate of 1 Mbps, type **2358**.

d. In the Application ID list, accept the default value (blank).

e. In the Active list, click **Y** (Yes) to enable this traffic profile.

4. Click **OK** to save the new profile.
**Creating ADSL Templates**

The C7 provides nine default ADSL templates. These templates are based on the various ADSL standards. You can apply ADSL templates to any ADSL port within the system to define the service attributes for that port. You can create up to 50 different ADSL templates, or you can use any of the nine default C7 ADSL templates.

You apply an ADSL template to an ADSL port by selecting the template ID (from the ADSL Template Identifier list) when configuring the port for service. Otherwise, you select an ADSL template when defining a Subscriber Template, and the ADSL template attributes are applied when you apply the Subscriber Template to the access port using the Add Subscriber wizard.

**Default ADSL Templates**

The C7 provides nine default ADSL templates. These templates are based on the various ADSL standards.

The following tables show the attributes of the nine default ADSL templates. The first table defines the legacy ADSL templates (pre-ADSL2+) that can be applied to any ADSL port. The second table defines the templates that can be applied to ADSL2+ ports only.

### ADSL Templates

<table>
<thead>
<tr>
<th>Parameter</th>
<th>MM</th>
<th>G.Lite</th>
<th>T1.413</th>
<th>G.DMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Identifier (ID)</td>
<td>MM</td>
<td>GLITE</td>
<td>T1413</td>
<td>GDMT</td>
</tr>
<tr>
<td>Description (DESC)</td>
<td>MM</td>
<td>GLITE</td>
<td>T1413</td>
<td>GDMT</td>
</tr>
<tr>
<td>Service Type (SRVTYPE)</td>
<td>MM</td>
<td>GLITE</td>
<td>T1413</td>
<td>GDMT</td>
</tr>
<tr>
<td>Channel 0 Selection/Allocation (CHNL0)</td>
<td>INTLV</td>
<td>INTLV</td>
<td>INTLV</td>
<td>INTLV</td>
</tr>
<tr>
<td>Chnl 0 Maximum Downstream Rate (XDSR0)</td>
<td>8160 Kbps</td>
<td>1536 Kbps</td>
<td>8160 Kbps</td>
<td>8160 Kbps</td>
</tr>
<tr>
<td>Chnl 0 Minimum Downstream Rate (MDSR0)</td>
<td>384 Kbps</td>
<td>384 Kbps</td>
<td>384 Kbps</td>
<td>384 Kbps</td>
</tr>
<tr>
<td>Chnl 0 Maximum Upstream Rate (XUSR0)</td>
<td>800 Kbps</td>
<td>512 Kbps</td>
<td>800 Kbps</td>
<td>800 Kbps</td>
</tr>
<tr>
<td>Chnl 0 Minimum Upstream Rate (MUSR0)</td>
<td>128 Kbps</td>
<td>128 Kbps</td>
<td>128 Kbps</td>
<td>128 Kbps</td>
</tr>
<tr>
<td>Target Downstream SNR Margin (TMDS)</td>
<td>8 dB</td>
<td>8 dB</td>
<td>8 dB</td>
<td>8 dB</td>
</tr>
<tr>
<td>Maximum Downstream SNR Margin (XMDS)</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
</tr>
<tr>
<td>Minimum Downstream SNR Margin (MMDS)</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
</tr>
<tr>
<td>Target Upstream SNR Margin (TMUS)</td>
<td>8 dB</td>
<td>8 dB</td>
<td>8 dB</td>
<td>8 dB</td>
</tr>
<tr>
<td>Maximum Upstream SNR Margin (XMUS)</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
</tr>
<tr>
<td>Minimum Upstream SNR Margin (MMUS)</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
</tr>
<tr>
<td>Maximum Downstream Latency (DSLAT)</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
</tr>
<tr>
<td>Maximum Upstream Latency (USLAT)</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
</tr>
<tr>
<td>Trellis Coding (TC)</td>
<td>ENABLED</td>
<td>ENABLED</td>
<td>ENABLED</td>
<td>ENABLED</td>
</tr>
</tbody>
</table>
### ADSL2+ templates

<table>
<thead>
<tr>
<th>Parameter</th>
<th>MM2+</th>
<th>ADSL2+</th>
<th>ADSL</th>
<th>READSL2</th>
<th>ANNEXM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Identifier (ID)</td>
<td>MM2+</td>
<td>ADSL2+</td>
<td>ADSL</td>
<td>READSL2</td>
<td>ANNEXM</td>
</tr>
<tr>
<td>Description (DESC)</td>
<td>MM2+</td>
<td>ADSL2+</td>
<td>ADSL</td>
<td>READSL2</td>
<td>ANNEXM</td>
</tr>
<tr>
<td>Service Type (SRVTYPE)</td>
<td>MM2+</td>
<td>ADSL2+</td>
<td>ADSL</td>
<td>READSL2</td>
<td>ANNEXM</td>
</tr>
<tr>
<td>Channel 0 Selection/Allocation (CHNL0)</td>
<td>INTLV</td>
<td>INTLV</td>
<td>INTLV</td>
<td>INTLV</td>
<td>INTLV</td>
</tr>
<tr>
<td>Chnl 0 Maximum Downstream Rate (XDSR0)</td>
<td>32736 Kbps</td>
<td>32736 Kbps</td>
<td>16352 Kbps</td>
<td>1536 Kbps</td>
<td>32736 Kbps</td>
</tr>
<tr>
<td>Chnl 0 Minimum Downstream Rate (MDSR0)</td>
<td>384 Kbps</td>
<td>384 Kbps</td>
<td>384 Kbps</td>
<td>384 Kbps</td>
<td>384 Kbps</td>
</tr>
<tr>
<td>Chnl 0 Maximum Upstream Rate (XUSR0)</td>
<td>800 Kbps</td>
<td>800 Kbps</td>
<td>800 Kbps</td>
<td>512 Kbps</td>
<td>800 Kbps</td>
</tr>
<tr>
<td>Chnl 0 Minimum Upstream Rate (MUSR0)</td>
<td>128 Kbps</td>
<td>128 Kbps</td>
<td>128 Kbps</td>
<td>128 Kbps</td>
<td>128 Kbps</td>
</tr>
<tr>
<td>Target Downstream SNR Margin (TMDS)</td>
<td>6 dB</td>
<td>6 dB</td>
<td>6 dB</td>
<td>6 dB</td>
<td>6 dB</td>
</tr>
<tr>
<td>Maximum Downstream SNR Margin (XMDS)</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
</tr>
<tr>
<td>Minimum Downstream SNR Margin (MMDS)</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
</tr>
<tr>
<td>Target Upstream SNR Margin (TMUS)</td>
<td>6 dB</td>
<td>6 dB</td>
<td>6 dB</td>
<td>6 dB</td>
<td>6 dB</td>
</tr>
<tr>
<td>Maximum Upstream SNR Margin (XMUS)</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
<td>16 dB</td>
</tr>
<tr>
<td>Minimum Upstream SNR Margin (MMUS)</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
<td>0 dB</td>
</tr>
<tr>
<td>Maximum Downstream Latency (DSLAT)</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
</tr>
<tr>
<td>Maximum Upstream Latency (USLAT)</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
</tr>
<tr>
<td>Trellis Coding (TC)</td>
<td>ENABLED</td>
<td>ENABLED</td>
<td>ENABLED</td>
<td>ENABLED</td>
<td>ENABLED</td>
</tr>
<tr>
<td>Rate Adaptation MODE Downstream (RAMODEDS)</td>
<td>Init</td>
<td>Init</td>
<td>Init</td>
<td>Init</td>
<td>Init</td>
</tr>
<tr>
<td>Rate Adaptation MODE Upstream (RAMODEUS)</td>
<td>Init</td>
<td>Init</td>
<td>Init</td>
<td>Init</td>
<td>Init</td>
</tr>
<tr>
<td>Rate Adaptation Upshift Margin DownStream (RAUMDS)</td>
<td>9 dB</td>
<td>9 dB</td>
<td>9 dB</td>
<td>9 dB</td>
<td>9 dB</td>
</tr>
<tr>
<td>Rate Adaptation Downshift Margin DownStream (RADMDS)</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
</tr>
<tr>
<td>Rate Adaptation Upshift Time Downstream (RAUTDS)</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
</tr>
<tr>
<td>Rate Adaptation Downshift Time Downstream (RADTDS)</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
</tr>
<tr>
<td>Rate Adaptation Upshift Margin Upstream (RAUMUS)</td>
<td>9 dB</td>
<td>9 dB</td>
<td>9 dB</td>
<td>9 dB</td>
<td>9 dB</td>
</tr>
<tr>
<td>Rate Adaptation Downshift Margin Upstream (RADMUS)</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
</tr>
<tr>
<td>Rate Adaptation Upshift Time Upstream (RAUTUS)</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
</tr>
<tr>
<td>Rate Adaptation Downshift Time Upstream (RADTUS)</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
<td>60 sec.</td>
</tr>
<tr>
<td>Power Management MODE (PMMODE)</td>
<td>L0</td>
<td>L0</td>
<td>L0</td>
<td>L0</td>
<td>L0</td>
</tr>
<tr>
<td>L0 Time (L0TIME)</td>
<td>255 sec.</td>
<td>255 sec.</td>
<td>255 sec.</td>
<td>255 sec.</td>
<td>255 sec.</td>
</tr>
<tr>
<td>L2 Max Aggregate Tx Pwr Reduction (L2ATPR)</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
<td>3 dB</td>
</tr>
<tr>
<td>L2 Minimum Data Rate in Low Power Mode (L2MINR)</td>
<td>1024 Kbps</td>
<td>1024 Kbps</td>
<td>1024 Kbps</td>
<td>1024 Kbps</td>
<td>1024 Kbps</td>
</tr>
</tbody>
</table>
### ADSL Port Parameter Definitions

Definitions of the ADSL port parameters follow:

**Profile Identifier (ID):** A number that uniquely identifies an ADSL template. You can create up to 50 custom ADSL templates that can be applied to any ADSL port in the system. Enter a number between 1 and 50.

**Description (DESC):** A user-defined character string of up to 11 characters. Use this field to add descriptive information about the template.

**Service Type (SRVTYPE):** Specifies the ADSL operating modes that dictate the ADSL handshaking protocol, channel capacity, and other physical line characteristics based on ADSL specifications. Select one of the following values:

- **MM2+** (multi-mode 2+): Allows the port to automatically detect and train up to the service type supported by the CPE; supports ADSL2+, READSL2, and ADSL2 standards as well as G.DMT, T1-413, and G.Lite standards
- **ADSL2+:** ADSL2+ standards specification
- **ADSL2:** ADSL2 standards specification
- **READSL2** (Reach Extended ADSL2): READSL2 standards specification
- **ANNEXM:** ADSL2/ADSL2+ Annex M standards specification
- **MM** (multi-mode): Allows the port to automatically detect and train up to the service type supported by the CPE; supports G.DMT, T1-413, and G.Lite standards
- **GDMT:** G.DMT standards specification
- **T1413:** T1.413 standards specification
- **GLITE:** G.Lite standards specification

The default value is **MM2+** for ADSL2+ ports and **MM** for legacy ADSL ports. To train up, the CPE must support the selected mode.

**Channel 0 Selection/Allocation (CHNL0):** Specifies the operating mode of the primary channel. Select one of the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>MM2+</th>
<th>ADSL2+</th>
<th>ADSL2</th>
<th>READSL2</th>
<th>ANNEXM</th>
</tr>
</thead>
<tbody>
<tr>
<td>L2 Exit Rate Threshold (L2EXITR)</td>
<td>512 Kbps</td>
<td>512 Kbps</td>
<td>512 Kbps</td>
<td>512 Kbps</td>
<td>512 Kbps</td>
</tr>
<tr>
<td>L2 Entry Rate Threshold (L2ENTRYR)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>L2 Entry Time Threshold (L2ENTRYT)</td>
<td>1800 sec.</td>
<td>1800 sec.</td>
<td>1800 sec.</td>
<td>1800 sec.</td>
<td>1800 sec.</td>
</tr>
<tr>
<td>DownStream Start Tone (DSST)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>DownStream End Tone (DSET)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>UpStream Start Tone (USST)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>UpStream End Tone (USET)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
• **FAST** – specifies a minimum of 4 ms delay
• **INTLV** – specifies a delay greater than or equal to 5 ms

The default value is INTLV.

**Chnl 0 Max Downstream rate (XDSR0):** Specifies the maximum downstream rate for channel 0. This parameter is specified in kilobits per second (Kbps). Enter a number that is a multiple of 32. Valid range is 32 to 32736 (conditional).

**Chnl 0 Min Downstream rate (MDSR0):** Specifies the minimum downstream rate for channel 0. This parameter is specified in kilobits per second (Kbps). Enter a number that is a multiple of 32. Valid range is 32 to 32736 (conditional).

**Chnl 0 Max Upstream rate (XUSR0):** Specifies the maximum upstream rate for channel 0. This parameter is specified in kilobits per second (Kbps). Enter a number that is a multiple of 32. Valid range is 32 to 2048 (conditional); 32 to 3072 for Annex M.

**Chnl 0 Min Upstream rate (MUSR0):** Specifies the minimum upstream rate for channel 0. This parameter is specified in kilobits per second (Kbps). Enter a number that is a multiple of 32. Valid range is 32 to 2048 (conditional); 32 to 3072 for Annex M.

**Target downstream SNR margin (TMDS):** Specifies the target signal-to-noise ratio in dB for the downstream direction. Enter a value between 0 and 15.

**Maximum downstream SNR margin (XMDS):** Specifies the maximum signal-to-noise ratio in dB for the downstream direction. Enter a value between 0 and 31.

**Minimum downstream SNR margin (MMDS):** Specifies the minimum signal-to-noise ratio in dB for the downstream direction. Enter a value between –32 and +15.

**Target upstream SNR margin (TMUS):** Specifies the target signal-to-noise ratio in dB in the upstream direction. Enter a value between 0 and 15.

**Maximum upstream SNR margin (XMUS):** Specifies the maximum signal-to-noise ratio in dB for the upstream direction. Enter a value between 0 and 31.

**Minimum upstream SNR margin (MMUS):** Specifies the minimum signal-to-noise ratio in dB for the upstream direction. Enter a value between –32 and +15.

**Maximum Downstream Latency (DSLAT):** Specifies the tolerable delay of the data transmission in milliseconds (ms) for the downstream direction on an interleaved channel (if the CHNL0 parameter value is INTLV). Enter AUTO, or a number between 5 ms and 64 ms based on the following guidelines:

• Enter a lower number to prioritize delay over performance (less delay).
• Enter a higher number to prioritize performance over delay (more delay).
• Enter AUTO to optimize latency between delay and error performance.
**Maximum Upstream Latency (USLAT):** Specifies the tolerable delay of the data transmission in milliseconds (ms) for the upstream direction on an interleaved channel (if the CHNL0 parameter value is INTLV). Enter AUTO, or a number between 5 ms and 64 ms based on the following guidelines:

- Enter a lower number to prioritize delay over performance (less delay).
- Enter a higher number to prioritize performance over delay (more delay).
- Enter AUTO to optimize latency between delay and error performance.

**Trellis Coding (TC):** Enables trellis coding to improve the DSL system performance. Trellis coding is a method of forward error correction in which each signal element is assigned a value based on phase and amplitude to help the receiving modem determine if the element is received in error. It is used to meet performance margin requirements for long loops, or increase the transmission throughput under a specified performance margin; provides increased gain against background and cross-talk noise. The default value is ENABLED. Select DISABLED to turn off this performance enhancement.

**Exclusive ADSL2+ parameters**

The following additional parameters apply to ADSL2+ capable ports only:

**Rate Adaptation MODE DownStream (RAMODEDS):** Specifies whether the data rate for the downstream signal is allowed to vary dynamically as the noise level varies. There are two values:

- **Init** – The rate remains at its initial rate upon train-up and does not change.
- **Dynamic** – The rate is allowed to change automatically in response to changes in the noise level. (Note that this may not be supported by all CPE.)

**Rate Adaptation MODE UpStream (RAMODEUS):** Specifies the rate adaptation mode upstream. There are two values:

- **Init** – The rate remains at its initial rate upon train-up and does not change.
- **Dynamic** – The rate is allowed to change automatically in response to changes in the noise level. (Note that this may not be supported by all CPE.)

**Rate Adaptation Upshift Margin DownStream (RAUMDS):** Applies only when dynamic rate adaptation is specified. Specifies the noise margin in decibels (dB) that triggers an increase in the downstream data rate. For the increase to occur, the noise margin must stay above this value for the time specified in Rate Adaptation Upshift Time DownStream (RAUTDS). The range of values is 0 to 31 dB. RAUMDS must be greater than RADMDS.

**Rate Adaptation Downshift Margin DownStream (RADMDS):** Applies only when dynamic rate adaptation is specified. Specifies the noise margin in decibels (dB) that triggers a decrease in the downstream data rate. For the decrease to occur, the noise margin must stay below this value for the time specified in Rate Adaptation Downshift Time DownStream (RAUTDS). The range of values is 0 to 31 dB. RAUMDS must be greater than RADMDS.
Rate Adaptation Upshift Time Downstream (RAUTDS): Applies only when dynamic rate adaptation is specified. Specifies the duration in seconds that the downstream noise margin must stay above the Rate Adaptation Upshift Margin Downstream (RAUMDS) before the modem increases the downstream data rate. The valid range is 0 to 16383 seconds. 0 disables the feature.

Rate Adaptation Downshift Time Downstream (RADTDS): Applies only when dynamic rate adaptation is specified. Specifies the duration in seconds that the downstream noise margin must stay below the Rate Adaptation Downshift Margin Downstream (RADMDS) before the modem decreases the downstream data rate. The valid range is 0 to 16383 seconds. 0 disables the feature.

Rate Adaptation Upshift Margin UpStream (RAUMUS): Applies only when dynamic rate adaptation is specified. RAUMUS must be greater than RADMUS. The default value is 9 dB.

Rate Adaptation Downshift Margin UpStream (RADMUS): Applies only when dynamic rate adaptation is specified. RAUMDS must be greater than RADMDS. The default value is 3 dB.

Rate Adaptation Upshift Time UpStream (RAUTUS): Applies only when dynamic rate adaptation is specified. Specifies the number of seconds for rate adaptation upshift. The default value is 30.

Rate Adaptation Downshift Time UpStream (RADTUS): Applies only when dynamic rate adaptation is specified. Specifies the number of seconds for rate adaptation downshift. The default value is 30.

Power Management MODE (PMMODE): There are four options for ADSL Power Management states:

- **L0** – Specifies to operate in full power mode at all times. May not be supported by all CPE.
- **L2** – Specifies a low power state for use when there is little or no traffic. When traffic decreases, the ADSL2 transitions into L2 low power mode and overall power consumption is reduced. L2 allows keep-alive traffic and returns to L0 mode within 2 DMT frames. Wideband energy transmitted during L2 mode. May not be supported by all CPE.
- **L2L3** – Specifies either L2 or L3 power management state. May not be supported by all CPE.
- **L3** – Specifies a sleep mode when power is not required. The L3 power state is used when the user is not on-line and there is no traffic on the ADSL2 connection. When in L3 power management mode, the ADSL2 connection goes through an initialization process before the connection can be re-established. May not be supported by all CPE.

**Note:** L3 power management state is not supported in this Release.
**L0 Time (L0TIME):** Minimum L0 Time interval between L2 exit and next L2 entry. The range is 0 to 255 seconds. The default value is 255. May not be supported by all CPE.

**L2 Time (L2TIME):** Minimum L2 time interval between L2 entry and first L2 trim. The range is 0 to 255 seconds. The default value is 255. May not be supported by all CPE.

**L2 Max Aggregate Tx Pwr Reduction (L2ATPR):** Maximum Aggregate Transmit Power Reduction in dB per L2 trim. The default value is 3. May not be supported by all CPE.

**L2 Minimum Rate in Low Power Mode (L2MINR):** Minimum net data rate (in Kbps) during the low power state (L2). If the actual user data rate is lower than L2MINR, raw cells are injected to maintain the provisioned value. The range is 256 to 1024 Kbps. The default value is 1024. May not be supported by all CPE.

**L2 Exit Rate Threshold (L2EXITR):** Downstream data rate threshold (in Kbps) that triggers autonomous exit from low power state (L2). The range is 1 to 1024 Kbps. The value must be less than L2MINR. The default value is 512. May not be supported by all CPE.

**L2 Entry Rate Threshold (L2ENTRYR):** Downstream data rate threshold (in Kbps) that triggers autonomous entry into low power state (L2). The value range is 1 to 1024. The value must be less than or equal to L2EXITR. The default value is 1. May not be supported by all CPE.

**L2 Entry Time Threshold (L2ENTRYT):** Minimum interval of time (in seconds) that the net data rate should stay below the L2-ENTRY-RATE (L2ENTRYR) before autonomous entry into low power state (L2). The value range is 900 to 65535 seconds. The default value is 180. May not be supported by all CPE.

**DownStream Start Tone (DSST):** Specifies the downstream start tone index. DSST must be less than or equal to DSET. See ADSL Tone Configurations on page 26 for valid ranges. The default value is 0.

Start and end tones, also known as start and end bins, define the low and high ranges of frequency bands used for the upstream and downstream signals. When high-power long-distance signals are carried in the same binder group as low-power short-distance signals, crosstalk can occur between the signals. To prevent crosstalk in some situations, you can specify start and end tones that define different frequency bands for different signals. The default value for start and end tones, 0, means the feature is disabled. DSST must be less than or equal to DSET.

**DownStream End Tone (DSET):** Specifies the downstream end tone index. DSET must be greater than or equal to DSST. See ADSL Tone Configurations on page 26 for valid ranges. The default value is 0.

**UpStream Start Tone (USST):** Specifies the upstream start tone index. USST must be less than or equal to USET. See ADSL Tone Configurations on page 26 for valid ranges. The default value is 0.
**UpStream End Tone (USET):** Specifies the upstream end tone index. USET must be greater than or equal to USST. See *ADSL Tone Configurations* on page 26 for valid ranges. The default value is 0.

**Report Remove/Restore (REPTRMVRST):** Enables/disables reporting of ADSL port remove/restore events (including modem retraining) in the system event logs. Reporting of these events can congest the system event logs. Y (Yes) enables reporting, N (No) disables reporting. The default value is N.

**Grade of Service (GOS):** The ID number (and description) of a defined Grade of Service profile. Grade of Service profiles define PM counter thresholds. To apply a Grade of Service profile, select a profile ID from the list. You can apply the default Grade of Service profile (DEFLT) defined by the Standards, apply a custom profile, or select OFF to disable reporting of threshold crossing alerts. The default value is OFF.

**ADSL Tone Configurations**

You may select the index of the start and end tones in upstream and downstream directions. If any of the tone parameters are set to 0, the provisioned values of the remaining tone settings are ignored.

Ranges and defaults for the supported service types are shown in the following table:

<table>
<thead>
<tr>
<th>Service Type</th>
<th>DSST</th>
<th>DSET</th>
<th>USST</th>
<th>USET</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.DMT, G.LITE, T1.413, ADSL2</td>
<td>32–255</td>
<td>32–255</td>
<td>6–31</td>
<td>6–31</td>
</tr>
<tr>
<td>ADSL2+</td>
<td>32–511</td>
<td>32–511</td>
<td>6–31</td>
<td>6–31</td>
</tr>
<tr>
<td>ANNEXM</td>
<td>64–511</td>
<td>64–511</td>
<td>6–63</td>
<td>6–63</td>
</tr>
</tbody>
</table>

**Note:** Tone configuration feature does not apply to the MM2+ and MM service types.
Creating Custom ADSL Templates

Typically, creating a custom ADSL template requires changing only three parameters from the defaults: Service Type, Maximum Upstream Rate, and Maximum Downstream Rate. Modify other parameters as needed for your applications.

To create an ADSL template

1. On the iMS Navigation Tree, click the Network level.
2. In the Work Area, click Profile > ADSL Template.
3. On the toolbar, click Create to display the ADSL Template dialog box.
4. In the ADSL Template dialog box, do the following:
   a. In the Profile Identifier box, type an ID number to identify the new profile (1 to 50).
   b. In the Description box, type a name to describe the profile (maximum of 11 alphanumeric characters).
   c. In the Service Type list, select a service type from among the nine default C7 ADSL templates.

   **Note:** The default attributes from the template you select will import into your new template. The displayed parameters and default values may change accordingly. Use these imported defaults as a baseline from which to define your new custom ADSL template.

   d. In the Maximum Downstream Rate - Channel 0 box, type a maximum transmission rate.
   e. In the Minimum Downstream Rate - Channel 0 box, type a minimum transmission rate.
   f. In the Maximum Upstream Rate - Channel 0 box, type a maximum transmission rate.
g. In the Minimum Upstream Rate - Channel 0 box, type a minimum transmission rate.
h. Modify the remaining parameter values as needed for your service requirements.

**Note:** Hold your mouse pointer over an input box to display the valid range for the parameter.

5. Click **OK** to save the new ADSL template.

### Creating Subscriber Templates

To simplify provisioning of broadband services for new subscribers, and to minimize configuration errors, you can create Subscriber Templates that define your different service offerings. When you turn up service for new subscribers, you simply apply the appropriate Subscriber Template to the subscriber access ports, and the iMS automatically configures the port and the end-to-end cross-connection(s).

Configure each Subscriber Template for either ADSL or ONT Ethernet access port types. Subscriber Templates support both data (Internet) and video service configurations, so you can configure each Subscriber Template for broadband Internet service only, video service only, or both services together.

The C7 supports up to 20 different Subscriber Templates, so you can create multiple templates to support various types of service. For example, suppose you provide several tiers of ADSL services and ONT Ethernet services. You could create multiple templates such as “DSL Gold” and "DSL Platinum" for ADSL Internet subscribers; “ONT Eth 10Mbps” and "ONT Eth 15Mbps" for ONT Internet subscribers; and so on.

With Subscriber Templates, you configure each service offering only *once*, instead of repeatedly provisioning all of the configuration information every time you add a new subscriber. Subscriber Templates get applied to access ports by the *Add Subscriber* wizard when you add new subscriber connections to the network.

### To create a Subscriber Template

1. On the File menu, click **Create > Subscriber > Subscriber Template**.

2. In the Subscriber Template dialog box, do the following:
   a. In the Template ID box, type an ID number (from 1 to 20) for the new template.
   b. In the Description box, type a brief description for the template (up to 32 characters in length).
   c. In the Template Type list, select the type of access port (**ADSL** or **ONT**) to which the template shall apply.
d. (Conditional) For ADSL template types, in the ADSL Template list, select an ADSL service template to apply to ADSL ports.

3. Select the **Data Service** check box to include Internet service connections in this template.

   **Note:** Subscriber Templates provide default values for the Data Service connection attributes. Modify the default Data VC parameter values as needed.

4. To include video service connections in this template, select the **Video Service** check box. Then set the Video Service connection attributes according to the services provided. See the *Calix C7 Video Services Guide* for instructions.

5. Click **Create** to save the new Subscriber Template.
Chapter 3

Configure the Internet Uplink

This chapter describes how to configure a C7 packet trunk port for Internet uplink service. The C7 supports Ethernet and ATM interface types for Internet uplinks.

Tasks Covered

This chapter covers the following configuration tasks:

- Configuring an Ethernet uplink, including routing support on the uplink card.
- Configuring an ATM uplink.
Configuring an Ethernet Uplink

This section describes how to configure an Ethernet port to provide the Internet uplink, including how to configure routing support on the uplink card.

The Calix C7 supports Ethernet uplinks using the GE-2p or GE-2p/FE-4p plug-in cards, which are equipped with Gigabit Ethernet (GE) and Fast Ethernet (FE) interfaces. The GE-2p and GE-2p/FE-4p cards support static routing, Routed Bridged Encapsulation, DHCP Relay with Option 82, and PPPoE Relay.

The GE-2p and GE-2p/FE-4p cards are functionally identical, except that the GE-2p/FE-4p card is industrially rated to support deployments in outdoor remote terminals. Each card provide six Ethernet ports, including two GE ports and four FE ports. In the C7 iMS, the Ethernet ports on the GE-2p and GE-2p/FE-4p cards are identified as follows:

- Ports 1 and 2 are the Gigabit Ethernet (GE) ports.
- Ports 3, 4, 5, and 6 are the Fast Ethernet (FE) ports.

Configuration Guidelines for Ethernet Uplinks

Follow these guidelines when configuring an Ethernet port for Internet uplink service:

- The GE-2p/FE-4p uplink card can reside in any C7 node. The GE-2p card can reside only in an environmentally-controlled node.

  **Note:** For simplicity, all subsequent references to "GE-2p" in this guide apply to both the GE-2p and GE-2p/FE-4p cards.

- The GE-2p card does not currently support equipment protection for redundant uplinks.
- The GE-2p card has two Gigabit Ethernet ports and four Fast Ethernet (10/100) ports.
- The GE-2p card currently supports up to 8,000 total cross-connections.
- Typical configurations require at least two IP interfaces on the GE-2p uplink card—one on the physical Ethernet uplink interface and, if supporting RBE connections, one or more on the PP1 to define the subscriber subnet(s) for DHCP relay. All IP interface addresses must belong to different subnets.
- One Ethernet uplink can support up to 5,000 PPPoE sessions, and up to 5 sessions (hosts) on a single subscriber port.
- PPPoE support requires only a cross-connection from the subscriber port to the GE-2p PP1 port.
- PPPoE connections do not require Layer 3 routing support, so no IP interfaces are required on GE-2p to support only PPPoE sessions. However, Calix recommends configuring an IP interface on the physical uplink port to support other Layer 3 utilities from the C7, such as IP ping.
• The GE-2p card can support mixed connection types (DHCP relay hosts, static hosts, and PPPoE hosts).

Starting point

Before starting the uplink configuration process, check that the following conditions are met:
• Transport is established to all C7 nodes providing broadband Internet service.
• The GE-2p card providing the uplink interface is installed and wired.

Next Steps

Perform the following tasks according to your application requirements:

1. Configure the Ethernet port for service.
   • If the uplink facility is a GE port, go to Configuring a Gigabit Ethernet Port (on page 34).
   • If the uplink facility is an FE port, go to Configuring a Fast Ethernet Port (on page 35).

2. Configure IP interfaces on the GE-2p card. See Configuring IP Interfaces (on page 37) for details.

   Note: Step 3 is not required if the Ethernet uplink shall support only PPPoE connections.

3. Configure DHCP relay and routing support for subscribers with Routed Bridged Encapsulation (RBE) connections.
   • Configure static IP routes to define routes from the GE-2p card to external subnets. See Configuring Static IP Routes (on page 38) for details.
   • Configure a DHCP server connection on the GE-2p card to support DHCP relay for RBE subscribers. See Configuring DHCP Server Connections (on page 39) for details.
   • Configure one or more sub interface bindings to support DHCP relay for RBE subscribers. See Configuring Sub Interface Bindings (on page 40) for details.
   • (Option) Configure static IP hosts in the GE-2p routing table. See (Optional) Creating Static IP Hosts (on page 42) for details.

   Note: PPPoE traffic is forwarded at Layer 2, so PPPoE connections do not require the routing support provided by the GE-2p card. However, Calix recommends configuring IP interfaces on the physical Ethernet ports even for PPPoE uplink applications, to support other Layer 3 functions such as IP ping. If your Ethernet uplink shall support only PPPoE Internet connections, perform Steps 1 and 2, then skip the remaining steps.
Configuring a Gigabit Ethernet Port

The GE-2p card is equipped with two Gigabit Ethernet ports that can serve as Internet uplinks.

Gigabit Ethernet port settings

The following table lists the parameter values for a Gigabit Ethernet port.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Valid Options</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tagged</td>
<td>N (No)</td>
<td>N</td>
</tr>
<tr>
<td>Maximum Transmission</td>
<td>1518 (bytes)</td>
<td>1518</td>
</tr>
<tr>
<td>Policing</td>
<td>N (disabled)</td>
<td>N</td>
</tr>
<tr>
<td>Speed</td>
<td>Automatic 1000 (Mbps)</td>
<td>Automatic</td>
</tr>
<tr>
<td>Duplex</td>
<td>Automatic Full</td>
<td>Automatic</td>
</tr>
<tr>
<td>Laser Enabled</td>
<td>Y (Yes)</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>N (No)</td>
<td></td>
</tr>
</tbody>
</table>

Note: Some routers do not support automatic detection of transmission rate or duplex mode. If connecting to such a device, specify the transmission rate (Speed) and duplex mode (Duplex) on the GE port instead of accepting the default Automatic option.

To configure a GE port for service

1. On the iMS Navigation Tree, click the shelf containing the GE-2p card.
2. Double-click the card to view its ports, then click the GE port to configure.
3. In the Work Area, on the Provisioning tab, place the port out of service as follows:
   a. In the Primary Service State list, click OOS.
   b. Click Apply to place the port out of service. In the confirmation dialog box, click OK.
4. Set the GE port parameters as follows:
   a. In the Tagged list, click N to disable tagging.
   b. In the Policing list, click N to disable policing.
c. In the Speed list, click **Automatic**. If the far-end device does not support automatic detection, click **1000** (Mbps).

d. In the Duplex list, click **Automatic**. If the far-end device does not support automatic detection, click **Full**.

e. In the Laser Enabled list, click **Y** to enable the transceiver.

f. In the Primary Service State list, click **IS**.

5. Click **Apply** to update settings and place the port into service. In the confirmation dialog box, click **OK**.

### Configuring a Fast Ethernet Port

The GE-2p card is equipped with four 10/100 Fast Ethernet ports that can provide Internet uplinks.

#### Fast Ethernet port settings

The following table lists the parameter values for a Fast Ethernet port.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Valid Options</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tagged</td>
<td>N (No)</td>
<td>N</td>
</tr>
<tr>
<td>Maximum Transmission</td>
<td>1518 (bytes)</td>
<td>1518</td>
</tr>
<tr>
<td>Policing</td>
<td>N (disabled)</td>
<td>N</td>
</tr>
<tr>
<td>Speed</td>
<td>Automatic</td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td>10 (Mbps)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100 (Mbps)</td>
<td></td>
</tr>
<tr>
<td>Duplex</td>
<td>Automatic</td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td>Half</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Full</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Some routers do not support automatic detection of transmission rate or duplex mode. If connecting to such a device, specify the transmission rate (Speed) and duplex mode (Duplex) on the FE port instead of accepting the default **Automatic** option.
To configure a FE port for service

1. On the iMS Navigation Tree, click the shelf containing the GE-2p card.

2. Double-click the card to view its ports, then click the FE port to configure.

3. In the Work Area, on the Provisioning tab, place the port out of service as follows:
   a. In the Primary Service State list, click **OOS**.
   b. Click **Apply** to place the port out of service. In the confirmation dialog box, click **OK**.

4. Set the FE port parameters as follows:
   a. In the Tagged list, click **N** to disable tagging.
   b. In the Policing list, click **N** to disable policing.
   c. In the Speed list, click **Automatic**. If the far-end device does not support automatic detection, click **10** or **100** (Mbps) per the uplink service requirements.
   d. In the Duplex list, click **Automatic**. If the far-end device does not support automatic detection, click **Full**.
   e. In the Primary Service State list, click **IS**.

5. Click **Apply** to update settings and place the port into service. In the confirmation dialog box, click **OK**.
Configuring IP Interfaces

Configuring an IP interface assigns an IP address to a physical or logical port on the GE-2p card to enable traffic routing at Layer 3.

IP interfaces assigned to the physical Ethernet ports face externally, toward the far-end devices (typically routers) connected to the GE or FE ports. Each physical port on the GE-2p card must be configured with at least one IP interface to support routing on that port. IP interfaces assigned to the card's logical port, Pseudo Port 1, face internally, toward the subscriber side of the C7 network. Pseudo Port 1 (PP1) supports multiple IP interfaces.

Configure an IP interface on the physical GE or FE uplink port (as well as each additional physical port that connects to a far-end device). Then configure IP interfaces on PP1 for each subnet within the C7 network that the GE-2p must route to. All IP interfaces configured on the GE-2p card must belong to different subnets.

When you configure an IP interface on PP1 to support a sub interface binding, be sure to assign a subnet mask address with enough host bits to support the subscriber-side entity that you will bind to it. The subnet mask should provide at least as many host addresses as the number of ports that reside within the binding's subscriber-side entity.

Note: PPPoE traffic is forwarded at Layer 2, so no IP interface is required on GE-2p PP1 to support PPPoE subscriber sessions. However, Calix recommends configuring IP interfaces on the physical Ethernet ports even for PPPoE uplink applications, to support other Layer 3 functions such as IP ping.

To configure an IP interface

1. On the File menu, click Create > IP > IP-IF.
2. In the IP Interface dialog box, do the following:
   a. In the Shelf list, select the shelf containing the GE-2p uplink card.
   b. In the Processor Port list, select the GE, FE, or PP1 port on which to assign the IP interface.
   c. In the IP Address box, type an IP address for the IP interface.
   d. In the Mask box, type a subnet mask for the IP interface.
3. Click Add to place the IP interface assignment into the IP Interface(s) to be created area.
4. Repeat Steps 2 and 3 to configure additional IP interfaces as needed.
5. Click Create to save the new IP interface(s).
Configuring Static IP Routes

Use static IP routes to define paths to IP hosts that reside on external networks or subnets. As a static router, the GE-2p card can only route to destinations that it is aware of (i.e., subnets that you defined when you created its IP interfaces). To enable routing to other hosts not on existing GE-2p subnets, configure static routes to those external hosts or subnets.

Create a default route to the gateway router. The gateway router address must belong to the same subnet as the uplink interface address. To configure the default route, create a new static route with a destination IP address of 0.0.0.0, a netmask of 0.0.0.0, and the IP address of the router interface as the gateway address. Any packets that the GE-2p card receives with an unrecognized destination IP address will be forwarded to the default gateway.

**To create a default route (to define the network default gateway)**

1. On the File menu, click Create > IP > IP Route.
2. In the IP Route dialog box, do the following:
   a. In the Shelf list, select the shelf containing the GE-2p uplink card (connected to the gateway router).
   b. In the IRC/GE Address list, select the slot address of the identified GE-2p card.
   c. In the IP Route box, type 0.0.0.0.
   d. In the Mask box, type 0.0.0.0.
   e. In the Gateway box, type the IP address of the default gateway router.
   f. Click Add to place the route into the IP Route(s) To Be Created area.
3. Click Create to save the default route.

**To configure a static IP route**

1. On the File menu, click Create > IP > IP Route.
2. In the IP Route dialog box, do the following:
   a. In the Shelf list, select the shelf containing the GE-2p card to store the route.
   b. In the IRC/GE Address list, select the slot address of the identified GE-2p card.
   c. In the IP Route box, type the destination network or host IP address.
   d. In the Mask box, type the destination subnet mask.
   e. In the Gateway box, type the next-hop IP address (i.e., the next router interface in the path to the destination network or host address).
   f. Click Add to place the route into the IP Route(s) To Be Created area.
3. Repeat Step 2 to create additional IP routes as needed.
4. Click Create to save the new static IP route(s).
Configuring DHCP Server Connections

The GE-2p card serves as a DHCP relay agent to support dynamic allocation of IP addresses to DHCP clients.

To configure a DHCP server connection, specify the IP address of the DHCP server and the location of the GE-2p card providing the relay connection. If your DHCP server supports Option 82, select one of the following to enable Option 82:

- **STND** (Standard): Supplies the local and remote VC endpoint AIDs in the relay request.
- **DSL Forum 1**: Supplies the remote VC endpoint ID in the relay request per the format specified in DSL Forum 1.

If your DHCP server does not support Option 82, set the Option 82 parameter to **NONE**.

**Note:** Support for DHCP relay applies to RBE subscriber connections only. PPPoE connections do not require a DHCP server connection on the GE-2p uplink card.

**To configure a DHCP server connection**

1. On the File menu, click **Create > IP > DHCP Server**.
2. In the DHCP Server dialog box, do the following:
   a. In the Shelf list, select the shelf containing the GE-2p uplink card providing DHCP relay.
   b. In the Router Address list, select the slot address of the identified GE-2p card.
   c. In the IP Address box, type the IP address of the DHCP server.
   d. In the Option 82 list, click **STND** or **DSL Forum 1** to enable Option 82 relay, or click **NONE** to disable it.
   e. Click **Add** to place the configuration into the DHCP Server(s) To Be Created area.
3. Repeat Step 2 to configure relay connections to additional DHCP servers as needed.
4. Click **Create** to save the DHCP server configuration.

**Note:** If the DHCP server is not directly connected to an Ethernet port on the GE-2p card, you must configure a static route to it from the GE-2p uplink. See **Configuring Static IP Routes** (on page 38) for instructions.
Configuring Sub Interface Bindings

The GE-2p card uses sub interface bindings to support its DHCP relay function. Sub interface bindings create virtual subnets on the subscriber side of the C7 network. A sub interface binding maps subscriber ports to an IP interface on GE-2p PP1. That IP interface defines the subnet to which DHCP clients on those access ports will belong.

When relaying DHCP requests to the DHCP server, the GE-2p card checks the binding association of the port where the DHCP request originated to supply that IP interface as its relay agent IP address. The DHCP server, in turn, uses the supplied relay agent IP address to determine the subnet pool from which to pull an IP address to supply to the client.

Each sub interface binding involves binding one physical entity in the C7 network to one IP interface on the GE-2p card. The binding establishes a virtual subnet for that physical entity, where all DHCP clients within it will be supplied with IP addresses from the bound IP interface's subnet. You determine the size of the virtual subnet based on the physical entity you select to comprise the binding. The available entities vary in scale, from the entire network to a single port. You can select from among the following physical entity types:

- Network
- Node
- Shelf
- Equipment (card)
- Passive Optical Network (PON)
- Port (OC3/12/48, DS3p, ADSL, ONT Ethernet)

You can create smaller-scale bindings within the scope of existing larger-scale bindings. The smaller-scale binding will supersede any larger-scale binding that may encompass that specific entity. For example, you can create a network-level sub interface binding that binds the entire C7 network to IP interface 172.16.1.1, so that all DHCP clients in the network will belong to the 172.16.1.1 subnet. Later, you can create another sub interface binding that binds only Node 4 to IP interface 10.1.1.1, so that all clients on Node 4 will belong to the 10.1.1.1 subnet. Therefore, all clients in the network belong to the 172.16.1.1 subnet, except clients from Node 4, which belong to the 10.1.1.1 subnet instead.
Each IP interface supports only one sub interface binding. Therefore, carefully consider the scale of the physical entity that you bind to the IP interface to ensure that the virtual subnet created by the binding is appropriately sized for the number of required hosts. That is, the number of available host addresses within the IP interface subnet should match or exceed the number of hosts in the binding area.

To configure a sub interface binding

1. On the File menu, click Create > IP > Sub IF.
2. In the Scope area of the Sub IF Binding dialog box, do the following:
   a. In the Scope list, select a physical entity to comprise the virtual subnet.

   **Note:** The available parameters for physical addressing change according to the entity type selected.

   b. Based on the physical entity you selected, do one of the following:
      • If you selected Network, skip to Step 3.
      • If you selected Node or Shelf, in the Node Address or Shelf Address list, select the node or shelf to comprise the subnet.
      • If you selected Equipment, PON, or a port type:
         • In the Shelf Address list, select the shelf where the card, port, or PON is located.
         • In the Physical Location list, select the card, port, or PON to comprise the subnet.

3. In the IP Address Binding area of the Sub IF Binding dialog box, do the following:
   a. In the DHCP Relay Shelf list, select the shelf containing the GE-2p card providing DHCP relay.
   b. In the DHCP Relay AID list, select the identified GE-2p card.
   c. In the IP IF Binding list, select an IP interface (on PP1) to associate with the physical entity comprising the subnet.

   **Note:** DHCP clients will be supplied with addresses from this IP interface subnet.

4. Click Add to place the binding configuration into the Sub Interface Binding(s) to be created area.
5. Repeat Steps 2–4 to configure additional sub interface bindings as needed.
6. Click Create to save the new sub interface binding(s).
(Optional) Creating Static IP Hosts

**Note:** Creating static IP hosts is optional. Skip this section if you do not require static IP hosts.

You can assign static (“fixed”) IP addresses to hosts in your network by creating IP host entries in the GE-2p routing table. Creating static IP hosts enables the GE-2p to route traffic to hosts for which dynamic IP addressing and/or Address Resolution Protocol (ARP) is not available.

For example, if your network does not include a DHCP server, you can configure static IP host entries for modems or PCs in the network to provide those devices with IP addresses. Or, if ARP is not enabled on a host device, you can configure a static IP host entry for it.

### To configure a static IP host

1. On the File menu, click **Create > IP > IP Host**.
2. In the Static IP Host dialog box, do the following:
   a. In the IRC/GE Shelf list, select the shelf containing the GE-2p router card.
   b. In the IRC/GE Port list, select the slot address of the identified GE-2p card.
   c. In the Facility Shelf list, select the shelf containing the facility linking to the IP host.
   d. In the Facility Type list, select the facility type linking to the IP host.

**Note:** The available addressing parameters change according to the facility type selected.

e. Based on the facility type you selected, do one of the following:
   - If you selected an OCn port, DS3p port, AMP Ethernet port, or IMA group, in the Port list, select the port or IMA group linking to the host.
   - If you selected a Pseudo Port, STS facility, DS3p VC, or IMA group VC:
     ♦ In the Facility list, select the PP, STS, DS3p port, or IMA group linking to the host.
     ♦ In the VP box, type the VPI address of the host VC.
     ♦ In the VC box, type the VCI address of the host VC.
   - If you selected an Ethernet port (on this GE-2p card), skip to Step 2f.
   - If you selected an ADSL port:
     ♦ In the ADSL Port list, select the ADSL port linking to the host.
     ♦ In the Channel list, select a channel (0 or 1).
     ♦ In the VP box, type the VPI address of the host VC.
     ♦ In the VC box, type the VCI address of the host VC.
   - If you selected an ONT Ethernet port, in the Host Port list, select the port linking to the host.
f. (Optional) In the MAC Address box, type the MAC address of the host device.

**Note:** If you do not provide a MAC address, the GE-2p card will learn the host MAC address via ARP.

g. In the IP Address box, type the IP address of the host device.
h. In the Host Type box, click **STB** if the host device is a set top box. Otherwise, click **Other**.
i. Click **Add** to place the configuration into the Static IP Hosts To Be Created area.

**3.** Repeat Step 2 to create additional static IP hosts as needed.

**4.** Click **OK** to save the new static IP host configuration(s).
Configuring an ATM Uplink

This section describes how to configure an ATM trunk port to provide the network uplink. For ATM uplinks, the host Internet sessions do not terminate on the C7.

The following Calix C7 ATM plug-in cards can be used to provide Internet uplinks:

- OC3-4, OC12-4, OC48-1
- RAP-OC3/12, RAP-OC3/12/48, RAP-OC48
- DS3-12p, DS3-4p
- T1-6 A+T (IMA or UNI mode)

Configuration Guidelines for ATM Uplinks

Follow these guidelines when configuring an ATM port for Internet uplink service:

- The ATM uplink card can reside in any shelf or node.
- If you require equipment protection for redundant uplinks, the protection group must be configured before you configure the ATM port for uplink service.
- You must configure the ATM port as an external ATM UNI interface to provide uplink service.

Starting point

Before starting the uplink configuration process, check that the following conditions are met:

- Transport is established to all C7 nodes providing broadband Internet service.
- The ATM trunk card providing the uplink interface is installed and wired.
- Equipment protection is configured for the uplink card, if required and supported.

Next Step

Choose one of the following tasks based on your ATM uplink interface type:

- If the uplink facility is an OCn optical port, continue to Configuring an OCn Optical Uplink (on page 45).
- If the uplink facility is a DS3 port, continue to Configuring a DS3 Uplink (on page 47).
- If the uplink facility is an IMA interface, go to Configuring an IMA Uplink (on page 48).
- If the uplink facility is a T1 port, go to Configuring a T1 UNI Uplink (on page 51).
Configuring an OCn Optical Uplink

This section describes how to configure an OCn optical port to provide uplink service.

**Note:** If you are **NOT** using an OCn optical facility for your Internet uplink, skip this section.

The following OCn optical cards can be used to provide Internet uplinks:
- OC3-4, OC12-4, OC48-1
- RAP-OC3/12, RAP-OC3/12/48, RAP-OC48

**Configure an OCn optical port for uplink service**

Configure an OCn optical port to provide the uplink interface. First, configure the optical port for ATM service, then configure an STS facility on the port.

**To configure an OCn optical port for uplink service**

1. On the iMS Navigation Tree, click the shelf containing the optical card providing the uplink.
2. Double-click the optical card to view its ports. Click the port to configure.
3. In the Work Area, on the Provisioning tab, place the port out of service as follows:
   a. In the Primary Service State list, click **OOS**.
   b. Click **Apply** to place the port out of service. In the Confirmation dialog box, click **OK**.
4. Set the optical port parameters as follows:
   a. In the Laser Enable list, select **Y** (Yes) to enable signal transmission on this port.
   b. In the External Interface list, select **Y** (Yes) to define this port as an external interface.
   c. Set the remaining parameter values according to your requirements.
   d. In the Primary Service State list, click **IS**.
5. Click **Apply** to update settings and place the port into service. In the Confirmation dialog box, click **OK**.

**To define an STS facility on the optical port**

1. On the iMS Navigation Tree, double-click the optical card to view its ports. Click the port to provision.
2. On the File menu, click **Create > STS Path** to display the Create SONET Transport Signal Facilities dialog box.
3. In the Available STS area, do the following:
   a. In the Shelf list, select the shelf containing the optical card.
   b. In the Port list, select the optical port ID providing the uplink.
   c. In the Rate list, select the STS rate to apply to this optical port.
   d. In the STS facility list, click the STS facility ID to create.
   e. Click **ADD** to add the STS facility to the STS To Be Created area.

4. Click **Next** to display the New STS(n)c dialog box (where "n" equals the STS rate you selected in Step 3c).

5. In the New STS(n)c dialog box, do the following:
   a. (Optional) In the User Description box, type a brief description (up to 27 characters) for this STS facility.
   b. In the STS Mapping list, click **ATMUNI** to define this port as an ATM UNI interface.
   c. Set the remaining STS parameter values according to your requirements.

6. Click **OK** to apply the STS facility settings to the optical port.
Configuring a DS3 Uplink

This section describes how to configure an ATM DS3 port to provide uplink service.

**Note:** If you are NOT using a DS3 facility for your Internet uplink, skip this section.

The following DS3 cards can be used to provide Internet uplinks:

- DS3-12p
- DS3-4p, DS3E-4p

**Configure a DS3 port for uplink service**

Configure an ATM DS3 port to provide the uplink interface.

**To configure a DS3 port for uplink service**

1. On the Navigation Tree, click the shelf containing the DS3 packet card.
2. Double-click the DS3 card to view its ports, then click a DS3 port to configure.
3. In the Work Area, on the Provisioning tab, place the DS3 port out of service as follows:
   a. In the Primary Service State list, click **OOS**.
   b. Click **Apply** to place the port out of service. In the confirmation dialog box, click **OK**.
4. On the Provisioning tab, set the DS3 port parameters as follows:
   a. In the DS3 Interface Type list, click **UNI**.
   b. In the Line Build Out box, type the distance (in feet) to the far-end device.
   c. In the External Interface list, select **Y** (Yes) to define this port as an external interface.
   d. In the ATM Mapping list, click **Direct** or **PLCP** to match the signal from the far-end device.
   e. In the ATM Payload Scrambling list, click **Y** or **N** to match the signal from the far-end device.
   f. In the ATM Monitoring list, click **Y** or **N** to match the signal from the far-end device.
   g. Set the remaining parameter values according to your requirements.
   h. In the Primary Service State list, click **IS**.
5. Click **Apply** to update settings and place the port into service. In the confirmation dialog box, click **OK**.
Configuring an IMA Uplink

This section describes how to configure an IMA interface to provide uplink service.

**Note:** If you are *NOT* using an IMA facility for your Internet uplink, skip this section.

The C7 T1-6 A+T plug-in cards can be used to establish IMA groups for Internet uplinks.

Configure an IMA interface to provide the Internet uplink. First, configure the T1 ports for use in an IMA group. Then create an IMA group and add T1 links to it. Finally, configure the IMA group as an external UNI interface to provide uplink service.

**Configure T1 ports for use in an IMA group**

Configure T1 ports for IMA service before adding them to an IMA group.

**To configure T1 ports for use in an IMA group**

1. On the iMS Navigation Tree, click the shelf containing the T1-6 A+T card.
2. Double-click the T1-6 A+T card to view its ports. Hold the **Ctrl** key and click each T1 port to configure for use in an IMA group.
3. In the Work Area, on the Provisioning tab, click the first port in the list, then press the **Shift** key and click the last port in the list to select the ports to edit.
4. From the edit row, place the T1 ports out of service and set the DS1 port type as follows:
   a. In the Primary Service State list, click **OOS**.
   b. In the DS1 Type list, click **DS1** or **T1** per your application requirements.
   c. Click **Apply** to place the ports out of service and to display parameters for the selected signal type. In the Confirmation dialog box, click **OK**.
5. Repeat Step 3 to re-select the same T1 ports to edit.
6. From the edit row, set the T1 port parameters as follows:
   a. In the DS1 Format list, click **ESF**.
   b. In the DS1 Line Coding list, click **B8ZS**.
   c. In the DS1 Map list, click **N/A**.
   d. In the Timing Mode list, click **Source**.
   e. Set the remaining parameter values as required for your site or accept the defaults.
   f. In the Primary Service State list, click **IS**.
7. Click **Apply** to update settings and place the ports into service. In the Confirmation dialog box, click **OK**.
Create an IMA group and add T1 ports

Create an IMA group, then add T1 ports from the T1-6 A+T card to the IMA group. An IMA group may consist of two to six T1 ports from a single T1-6 A+T card. All T1 ports in an IMA group must reside on the same card.

To create an IMA group

1. On the File menu, click Create > Ports to open the new Ports Creation dialog box.
2. In the New Ports Creation dialog box, do the following:
   a. In the Shelf list, select the shelf containing the T1-6 A+T card.
   b. In the Port Type list, click IMA Group.
   c. In the list of available IMA group IDs, click an IMA group to create.
   d. Click Add to add the selected IMA group to the To Be Created Ports list.
   e. Click OK to create the IMA group.

To add T1 ports to an IMA group

1. On the iMS Navigation Tree, click the shelf containing the T1-6 A+T card, then click the IMA group to modify.
2. In the Work Area, on the Provisioning page, click the button next to the Physical Location Identifiers box to open the New Add T1 IMA dialog box.
3. In the New Add T1 IMA dialog box, do the following:
   a. In the Available Ports list, press the Ctrl key and click the T1 ports to add to the IMA group.
   b. Click Add to add the ports to the Selected Ports list.
   c. Click OK to add the ports to the IMA group.
Configure the IMA group as an uplink

Configure the IMA group providing the uplink as an external UNI interface.

**To configure an IMA group for uplink service**

1. On the iMS Navigation Tree, click the shelf containing the IMA group providing the uplink.
2. Click IMA Groups, then click the IMA group to configure.
3. In the Work Area, on the Provisioning tab, do the following:
   a. In the Primary Service State list, click **OOS**.
   b. Click **Apply** to place the IMA group out of service. In the Confirmation dialog box, click **OK**.
4. In the Work Area, on the Provisioning tab, do the following:
   a. In the Minimum Number of Facilities list, type the total number of T1 links in the IMA group.
   b. In the Mapping list, click **UNI**.
   c. In the External Interface list, click **Y**.
   d. In the Payload Scrambling list, click **Y** or **N** (enable or disable) to match the signal from the far-end device.
   e. Set the remaining parameter values according to your requirements. The default values are typically acceptable.
   f. In the Primary Service State list, click **IS**.
5. Click **Apply** to update settings and place the IMA group into service. In the Confirmation dialog box, click **OK**.
Configuring a T1 UNI Uplink

This section describes how to configure a T1 ATM UNI port to provide uplink service.

Note: If you are NOT using a T1 facility for your Internet uplink, skip this section.

The C7 T1-6 A+T plug-in cards can provide T1 UNI interfaces for Internet uplinks.

Configure a T1 port for uplink service

Configure a T1 UNI port to provide the uplink interface.

To configure a DS1 port for uplink service

1. On the iMS Navigation Tree, click the shelf containing the T1-6 A+T card.
2. Double-click the T1-6 A+T card to view its ports, then click a DS1 port to configure.
3. In the Work Area, on the Provisioning tab, place the T1 ports out of service and set the DS1 port type as follows:
   a. In the Primary Service State list, click OOS.
   b. In the DS1 Type list, click DS1 or T1 per your application requirements.
   c. Click Apply to place the port out of service and display parameters for the selected signal type. In the confirmation dialog box, click OK.
4. On the Provisioning page, do the following:
   a. In the DS1 Format list, click ESF.
   b. In the DS1 Line Coding list, click B8ZS.
   c. In the DS1 Map list, click UNI.
   d. In the External Interface list, click Y.
   e. In the Payload Scrambling list, click Y or N to match the signal from the far-end device.
   f. In the Timing Mode list, click Source.
   g. Set the remaining parameter values as required for your site or accept the defaults.
   h. In the Primary Service State list, click IS.
5. Click Apply to update settings and place the port into service. In the Confirmation dialog box, click OK.
Configure Subscriber Connections

This chapter describes how to configure the subscriber connections for broadband Internet service. Configuring the subscriber connections involves applying the service attributes to the subscriber port (for ADSL), and cross-connecting the subscriber ports (ADSL and/or ONT Ethernet) to the uplink.

Tasks Covered

This chapter covers the following configuration tasks:

- Creating the connections for subscriber service, including adding new subscriber connections and reconfiguring existing connections.
- Activating service on subscriber ports.
Creating Subscriber Connections

This section describes how to create new subscriber connections using the iMS Add Subscriber wizard. The Add Subscriber wizard applies a defined Subscriber Template to the access ports and automatically builds the cross-connections to the Internet uplink.

You can also use the iMS Reconfigure Subscriber wizard to reconfigure existing subscriber connections. The Reconfigure Subscriber wizard allows you to apply an updated Subscriber Template to the ports and to re-provision the cross-connects to change the connection attributes or to change the uplink type or destination.

Adding New Subscriber Connections

The Add Subscriber wizard simplifies provisioning and turn-up of new broadband subscribers to the network. Use the Add Subscriber wizard to automatically create all the necessary cross-connections between subscriber access ports and the uplink.

When you create subscriber connections using the Add Subscriber wizard, the iMS automatically applies a subscriber template (created previously) to the specified subscriber port(s) to define the broadband service attributes. The iMS then creates the end-to-end cross-connections required to deliver broadband service to the subscriber port(s).

The Add Subscriber wizard performs the following provisioning tasks:

- Automatically applies a Subscriber Template to the access ports to define the service attributes.
- Automatically creates the required cross-connections to the uplink.
- Automatically assigns VPI and VCI addresses to subscriber-side VC cross-connections.
- Automatically assigns traffic profiles to subscriber-side VC cross-connections.

Once the cross-connections are established, the subscriber port(s) can pass traffic.

To add subscriber connections to your network

1. On the Tools menu, click Subscriber Provisioning > Add Subscriber.
2. In the Add Subscriber dialog box, do the following:
   a. In the Template Type list, select the type of template to apply (ADSL or ONT).
   b. In the Template ID box, select the Subscriber Template to apply.
   c. In the Shelf Address list, select the shelf containing the subscriber port(s) to configure.
d. In the Subscriber Slot list, select the slot containing the subscriber port(s) to configure.

e. In the Subscriber Port list, click the port to configure. To select multiple ports, press the Ctrl key and click the ports to configure.

3. In the Data Source area, do the following:
   a. In the Uplink Type list, select the uplink facility type.
   b. In the Shelf Address list, select the shelf containing the uplink card.
   c. In the Uplink Address list, select the slot address of the uplink card.

   **Note:** If the Subscriber Template you selected in Step 2b supports video, then a Video Source area also appears in the dialog box. If the Video Source area appears, perform Step 4 to define the video ingress on the subscriber shelf. Otherwise, skip to Step 5.

4. (Conditional) In the Video Source area, do the following:
   a. In the Line Unit Type list, click the card type providing video ingress on the shelf where the subscriber port resides.
   b. In the Line Unit Address list, select the slot address of the identified video ingress card.
   c. In the IRC Address list, select the slot address of the IRC card in the network.

5. Click Add to place the subscriber connection(s) into the Subscriber(s) To Be Created area.

6. (Option) Repeat Steps 2–5 to add other connections to the configuration list as needed.

7. Click Apply to start creating the new subscriber connection(s).
Reconfiguring Subscriber Connections

The Reconfigure Subscriber wizard allows you to change the Subscriber Template applied to subscriber access ports, and to change the cross-connect attributes or switch uplink destinations for existing subscriber connections. The Reconfigure Subscriber automatically re-provisions existing subscriber connections according to the Subscriber Template(s) and uplink destination you specify.

The Reconfigure Subscriber wizard performs the following provisioning tasks:

- Automatically applies a Subscriber Template to the selected access ports to update the service attributes.
- Automatically deletes existing subscriber cross-connections and creates new connections to an uplink of your choice.

Once the cross-connections are re-established, the subscriber port(s) can pass traffic.

The Reconfigure Subscriber wizard provides an optional check box, Don't Disturb Connections that are not Part of Selected Templates. If selected, only the connection types defined in the template will be reconfigured. Any other cross-connections that may exist on the selected ports will remain untouched. Calix recommends selecting this option, which is selected by default.

**ALERT!** Service affecting procedure. Reconfiguring cross-connects temporarily disrupts service as the connection is deleted and rebuilt.

---

To reconfigure subscriber connections in your network

1. On the Tools menu, click **Subscriber Provisioning > Reconfigure Subscriber**.

2. In the Reconfigure Subscriber dialog box, do the following:
   a. In the Template Type list, select the type of template to apply (**ADSL** or **ONT**).
   b. In the Template ID box, select the Subscriber Template to apply.
   c. In the Shelf Address list, select the shelf containing the subscriber port(s) to configure.
   d. In the Subscriber Slot list, select the slot containing the subscriber port(s) to configure.
   e. In the Subscriber Port list, click the port to configure. To select multiple ports, press the **Ctrl** key and click the ports to configure.

3. In the Data Source area, do the following:
   a. In the Uplink Type list, select the uplink facility type.
   b. In the Shelf Address list, select the shelf containing the uplink card.
c. In the Uplink Address list, select the slot address of the uplink card.

**Note:** If the Subscriber Template you selected in Step 2b supports video, then a Video Source area also appears in the dialog box. If the Video Source area appears, perform Step 4 to define the video ingress on the subscriber shelf. Otherwise, skip to Step 5.

4. (Conditional) In the Video Source area, do the following:
   a. In the Line Unit Type list, click the card type providing video ingress *on the same shelf where the subscriber port resides.*
   b. In the Line Unit Address list, select the slot address of the identified video ingress card.
   c. In the IRC Address list, select the slot address of the IRC card in the network.

5. Click **Add** to place the configuration(s) into the Subscriber(s) To Be Created area.

6. (Option) Repeat Steps 2–5 to add configurations for other ports to the list as needed.

7. (Option) Select the **Don't Disturb Channels that are not Part of Selected Templates** check box to reconfigure only the connection types specified in the template.

8. Click **Apply** to start reconfiguring the subscriber connection(s).
Activating Service

When you have finished creating subscriber connections to the uplink, the broadband Internet service is ready to activate. To activate the service, the subscriber ports must be placed into the IS (In Service) state. This section describes how to place the C7 subscriber ports into service.

Placing Subscriber Ports Into Service

If you have not already done so, place the C7 subscriber ports into service as described below.

To place ADSL subscriber ports into service

1. On the iMS Navigation Tree, click the shelf containing the subscriber ports to activate.
2. On the Filter list, click Port > ADSL Port to show all ADSL ports on the selected shelf.
3. In the Work Area, click the Provisioning tab to see the ADSL port parameters.
4. On the Provisioning tab, press the Ctrl key and click the ADSL ports to activate.
   To select a full range of ports, click the first ADSL port, then press Shift and click the last port to activate.
5. From the edit row, in the PST list, click IS (In Service).
6. Click Apply to place the ADSL ports into service. In the confirmation dialog box, click OK.

To place ONT Ethernet subscriber ports into service

1. On the iMS Navigation Tree, click the shelf containing the subscriber ports to activate.
2. On the Filter list, click Passive Optical Network > ONT Ethernet to show all ONT Ethernet ports connected to the selected shelf.
3. In the Work Area, click the Provisioning tab to see the ONT Ethernet port parameters.
4. On the Provisioning tab, press the Ctrl key and click the ONT Ethernet ports to activate.
   To select a full range of ports, click the first port, then press Shift and click the last port to activate.
5. From the edit row, in the PST list, click IS (In Service).
6. Click Apply to place the ONT Ethernet ports into service. In the confirmation dialog box, click OK.
Configuration Complete

Once you have placed the subscriber ports into service, the configuration process is complete and the C7 is ready to pass Internet traffic.
Chapter 5

Troubleshooting and Maintenance

This chapter provides some general troubleshooting and maintenance practices for Calix C7 broadband Internet service applications.

Tasks Covered

This chapter covers the following tasks:

- Troubleshooting common issues for broadband Internet services.
- Using the Ethernet uplink troubleshooting utilities.
- Configuring xDSL power management.
- Modifying subscriber connections.
- Viewing PPPoE data for Ethernet uplinks
Troubleshooting Common Broadband Internet Service Issues

Most C7 broadband Internet service problems have similar causes. If you are experiencing trouble with broadband subscriber services, verify the following:

- Is the modem trained up?
- Is the modem provisioned properly?
- Is the ADSL traffic profile configured properly?
- Are the ADSL template parameters configured properly?
- Are the ADSL port parameters configured properly?
- Is the Ethernet service configured properly?
- Are the cross-connects provisioned properly in the C7 (with the correct VPI/VCI)?
- Are the cross-connects provisioned properly in the router or switch?
- Can users authenticate PPPoE?
- Can users get an IP address from the DHCP server?
- Does the PC have the correct static IP assigned (if not using an RBE or PPPoE connection)?
- Are there any alarms on the uplink or transport such as LOS, LOSPPL, or LOF?
- Are there any errors on the uplink or transport? Check the port level, the STS level, and the ATM level.
- Check the End-to-End detail view of the performance monitoring statistics to see where the cell count stops.
- Check ADSL PM statistics for line-side errors.

If you are unable to resolve the trouble after checking and clearing the listed issues, contact Calix Technical Support at 1-877-766-3500 for assistance.
Using the Ethernet Uplink Troubleshooting Utilities

The Calix C7 GE-2p card provides several troubleshooting and maintenance utilities to support Ethernet uplink applications. This section describes how to use the GE-2p Ethernet uplink troubleshooting utilities.

This section covers the following tasks:

- Pinging IP hosts.
- Tracing routes to IP hosts.
- DHCP lease maintenance, including viewing and manually terminating leases to DHCP clients.
- Modify Address Resolution Protocol (ARP) settings.

Ping IP Hosts

IP ping can be a useful troubleshooting tool for isolating network connection faults. Use the IP ping utility to verify network (Layer 3) connectivity between the GE-2p card and other IP devices, such as:

- The network default gateway router
- DHCP server
- Other GE-2p cards in the network
- Other IP hosts

Ping parameters

The ping utility includes four parameters that you can adjust for testing purposes. The default settings suffice in most cases.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Valid Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ping Timeout</td>
<td>The time to wait for a ping reply.</td>
<td>500–3000 milliseconds</td>
<td>500</td>
</tr>
<tr>
<td>Ping Count</td>
<td>The number of ping packets to send.</td>
<td>1–100</td>
<td>5</td>
</tr>
<tr>
<td>Ping Interval</td>
<td>The time interval between ping packets.</td>
<td>50–2000 milliseconds</td>
<td>50</td>
</tr>
<tr>
<td>Ping Packet Size</td>
<td>The data size for each ping packet.</td>
<td>0–1472 bytes</td>
<td>64</td>
</tr>
</tbody>
</table>
Note: Only one ping attempt at a time may be active on a GE-2p card.

To ping IP hosts from the GE-2p card

1. On the Navigation Tree, click the GE-2p card to ping from.
2. In the Work Area, click the IP tab, then click the Host tab.
3. Click the Action button, then click Ping Host to display the Command Processor IP Ping Host dialog box.
4. In the Command Processor IP Ping Host dialog box, do the following:
   a. In the Host IP Address box, type the IP address of the device to ping.
   b. (Optional) If necessary, modify the Ping Timeout, Ping Count, Ping Interval, and Ping Packet Size parameter values from the defaults.
   c. Click Ping Host.
5. Review the ping result messages in the Ping Result window. Click Cancel to close the dialog box.

![Ping Result](image)

Note: A result showing 100% packet loss indicates that the destination host is unreachable.
Trace Routes to IP Hosts

Tracing the route to an IP host can help to troubleshoot routing problems. Use the "traceroute" utility to test each hop in the path between the GE-2p card and another IP device in the network.

Traceroute parameters

The traceroute utility includes parameters that you can adjust for testing purposes. The default settings suffice in most cases.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Valid Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Probes</td>
<td>The number of probes to issue at each hop.</td>
<td>1–10</td>
<td>3</td>
</tr>
<tr>
<td>Wait Time</td>
<td>The maximum time to wait for a response to a probe.</td>
<td>1–30 seconds</td>
<td>5</td>
</tr>
<tr>
<td>Interval</td>
<td>The time to wait between sending each probe.</td>
<td>0–30 seconds</td>
<td>0</td>
</tr>
<tr>
<td>Maximum Failures</td>
<td>The number of probe failures to receive before advancing to the next hop.</td>
<td>0–30</td>
<td>3</td>
</tr>
<tr>
<td>First Hop</td>
<td>The number to use as the initial hop.</td>
<td>1–255</td>
<td>1</td>
</tr>
<tr>
<td>Maximum Hops</td>
<td>The maximum number of hops to detect before aborting the trace.</td>
<td>1–255</td>
<td>5</td>
</tr>
<tr>
<td>Protocol</td>
<td>The Layer 4 protocol for the probe packets to use. Only UDP is currently supported.</td>
<td>UDP ICMP</td>
<td>UDP</td>
</tr>
<tr>
<td>Base Port Used in UDP Probe Packets</td>
<td>The starting port number of a range to use for UDP probe packets (applies only when the Protocol is UDP).</td>
<td>1–65,535</td>
<td>33,434</td>
</tr>
</tbody>
</table>

Note: Only one traceroute request may be active on a GE-2p card at one time.

To trace the route to an IP host

1. On the Navigation Tree, click the GE-2p card from which to trace a route.
2. In the Work Area, click the IP tab, then click the Host tab.
3. On the toolbar, click the **Action** button, then click **Trace Host** to display the Trace Route dialog box.

4. In the Trace Route dialog box, do the following:
   a. In the Action Access Identifier list, select the slot address of the GE-2p card.
   b. In the Host IP Address box, type the IP address of the destination host to trace.
   c. (Optional) Modify the remaining parameter values from the defaults, if necessary.
   d. Click **Trace**.

5. Review the results displayed in the lower half of the dialog box. To close the dialog box, click **Close**.

   ![Trace Route Dialog Box](image)

   The trace results show the following information:
   - The number of router hops to the destination host.
   - The probe round-trip times (RTTs) to each hop, in milliseconds.
   - The IP address of each hop.
   
   The last hop is typically the destination host, unless the max hops limit was reached first. Each hop shows three RTT values, which equate to the minimum, maximum, and average round-trip times to that hop from the source.

**DHCP Lease Maintenance**

You can view the status of DHCP leases currently issued to DHCP clients on the C7 network. You can also manually terminate a lease if necessary.

**To verify the status of DHCP leases**

1. On the Navigation Tree, click the GE-2p card that connects to the DHCP server.
2. In the Work Area, click the **DHCP** tab, then click the **Lease** sub-tab.
3. In the current DHCP lease list, verify the status of individual leases.

### To delete a DHCP lease

1. On the Navigation Tree, click the GE-2p card that connects to the DHCP server.
2. In the Work Area, click the **DHCP** tab, then click the **Lease** sub-tab.
3. In the list of current DHCP leases, click the lease to delete.
4. On the toolbar, click **Delete** to terminate the lease. In the confirmation dialog box, click **OK**.

### Modify ARP Settings

The Address Resolution Protocol (ARP) is always enabled on the GE-2p card. However, you can modify the ARP age setting to define how long the GE-2p sustains routes to IP hosts discovered via ARP. Once the age time expires for an ARP host, the GE-2p deletes that entry from its routing table.

#### ARP global settings

The following table defines the global ARP settings.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Valid Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARP Age</td>
<td>The time to wait before deleting routes to IP hosts discovered via ARP.</td>
<td>240–65,535 seconds</td>
<td>1200</td>
</tr>
</tbody>
</table>

### To modify the GE-2p ARP age setting

1. On the Navigation Tree, click the GE-2p card to modify.
2. In the Work Area, click the **ARP** tab, then click the **Global** sub-tab.
3. In the ARP Age box, delete the value shown, then type a new age time value.
4. On the toolbar, click the **Apply** button to update the setting.
Configuring xDSL Power Management

The Calix C7 provides xDSL power management options to support services in remote cabinets. This section describes how to configure xDSL power management.

This section covers the following topics:

- About the C7 xDSL power management functions.
- Configuring the power shutdown priority for xDSL cards.
- Setting the Category 3 shutdown delay timer for the shelf.

About xDSL Power Management

The C7 can automatically disable xDSL data services in a remote cabinet when a power fault occurs, to reduce power consumption and extend battery life. Use the C7 power management feature to protect high-priority services such as lifeline POTS. All C7 xDSL plug-in cards (ADSL-24, ADSL2-24, COMBO-24, COMBO2-24, COMBO2-24D) feature a Power Category parameter that can be set for either Category 1 or Category 3 priority.

When an AC power failure occurs, the C7 will disable DSL cards provisioned for Category 3 priority. Cards provisioned for Category 1 are kept in service as long as sufficient backup power to the shelf is sustained. You can set a shelf-level delay timer for Category 3 shutdowns, from 0 to 480 minutes. The default setting is 10 minutes. For COMBO cards, only the DSL ports are shut down when the timer expires, while the DS0 ports remain in service.
Configuring the xDSL Power Shutdown Priority

You can configure the xDSL power shutdown priority on a per-card basis:

- **1 (Category 1):** Keeps all xDSL ports in service as long as sufficient power to the shelf is sustained.
- **3 (Category 3):** Disables all xDSL ports on the card once the shelf's delay timer expires, to conserve power for other high-priority services. Category 3 is the default priority for all xDSL cards.

*Note:* The Category 2 option is not currently supported.

To set the power shutdown priority for xDSL cards

1. On the iMS Navigation Tree, click a C7 shelf containing an xDSL card.
2. Click the xDSL card to configure, then in the Work Area, click the **Provisioning** tab.
3. In the Power Category list, click 1 or 3 to assign a power shutdown priority to the card.
4. Click **Apply** to update settings. In the Confirmation dialog box, click **OK**.

Setting the Category 3 Shutdown Timer

You can modify the Category 3 shutdown delay timer for the C7 shelf from the default (10 minutes).

To set the Category 3 Shutdown delay timer

1. On the iMS Navigation Tree, click the C7 shelf to configure.
2. In the Work Area, click **Shelf View**.
3. In the Shelf field, in the Category 3 Shutdown box, type a delay timer value from 0 to 480 minutes.
4. Click **Apply** to update settings. In the Confirmation dialog box, click **OK**.
Modifying Subscriber Connections

You may be required to modify subscriber connections for troubleshooting or maintenance purposes. However, cross-connect attributes cannot be modified. If a cross-connect requires modification, you must delete and re-provision it.

Calix recommends using the Reconfigure Subscriber wizard to re-provision existing subscriber cross-connects. See Reconfiguring Subscriber Connections (on page 56) for instructions. Otherwise, you can delete and manually rebuild the cross-connect. This section describes how to modify a subscriber connection by deleting and manually rebuilding it.

Deleting Subscriber Connections

The Delete Subscriber wizard allows you to delete subscriber connections from access ports and to remove existing service attributes that may be applied to the ports. The Delete Subscriber wizard automatically deletes all data and/or video connections according to the options you select.

The Delete Subscriber wizard provides the following optional check boxes:

- **Data Service**: Select this option to automatically delete data (Internet) connections from the selected port(s). This option is unselected by default.
- **Video Service**: Select this option to automatically delete video connections from the selected port(s). This option is unselected by default.

**ALERT!** Service affecting procedure. Deleting cross-connects disrupts service on the subscriber port.

To delete subscriber connections from your network

1. On the Tools menu, click **Subscriber Provisioning > Delete Subscriber**.
2. In the Delete Subscriber Service dialog box, do the following:
   a. In the Shelf Address list, select the shelf where the subscriber port(s) are located.
   b. In the Slot type list, select the type of card on which the subscriber port(s) reside.
   c. In the Subscriber Slot list, select the slot address where the subscriber port(s) are located.
   d. In the Subscriber Port list, click the port to delete connections from. To select multiple ports, press the **Ctrl** key and click the ports to delete.
3. Select the **Data Service** check box to delete data connections from the selected port(s).
4. Select the Video Service check box to delete video connections from the selected port(s).
5. Click Add to place the configuration(s) into the Subscriber Services To Be Removed area.
6. (Option) Repeat Steps 2–5 to add other subscriber connections to the list as needed.
7. Click Remove Sub to delete the subscriber connection(s) from the selected port(s).

Rebuilding Subscriber Cross-Connects

Calix recommends using the Add Subscriber or Reconfigure Subscriber wizards to create or re-provision subscriber connections. See Creating Subscriber Connections (on page 54) for instructions. However, you can manually rebuild a subscriber cross-connect as described below.

To create a subscriber cross-connection

1. On the File menu, click Create > Cross-Connect > VC to display the Select Cross-Connect Endpoints dialog box.
2. In the Source area, do the following to create the source endpoint on the subscriber port:
   a. In the Shelf list, select the shelf containing the subscriber port (i.e., the ADSL card or the OLTB-2 card that connects to the subscriber ONT).
   b. In the Type list, select the subscriber port type as follows:
      • For ADSL ports, click VC (ADSL).
      • For ONT Ethernet ports, click VC (ETH-ONT).
   c. In the list of ports, click the subscriber port to cross-connect.
   d. In the VP box, type a VPI value for the cross-connect endpoints. For example, type 0.
   e. In the VC box, type a VCI value for the cross-connect endpoints. For example, type 35.
   f. Click SRC to add the specified endpoints to the Source column in the Cross-Connects To Be Created area.
3. In the Destination/Drop area, do the following to create the destination endpoints:
   a. In the Shelf list, select the shelf containing the uplink port.
   b. In the Type list, select the facility type of the uplink port as follows:
      • For Ethernet uplinks, click VC (PP).
      • For OCn optical uplinks, click VC (STSn), where "n" is the STS facility type.
      • For DS3 uplinks, click VC (T3p).
For IMA uplinks, click **VC (IMA)**.

c. In the list of Destination endpoints, select the uplink port, STS path, or IMA group ID.

d. In the VP box, type a VPI value for the cross-connect endpoints. For ATM uplink types, enter a VPI value provided by your ISP (for example, type 1).

e. In the VC box, type a range of VCI values to match the number of ADSL source endpoints (for example 32 - 55). To have the iMS assign consecutive VCI values, select the Auto-increment check box.

f. Click **DEST** to add the new VC endpoints to the Destination column in the Cross-Connects To Be Created area.

4. In the Required Parameters area, do the following:

a. In the Cross-Connect Way list, click **2WAY** (default).

b. In the ATM Traffic Profile ID list, select an ATM traffic profile (for example, UBR).

c. In the Backward ATM Traffic Profile ID list, select an ATM traffic profile (for example, UBR).

d. In the Cross-Connect Path list, click **WORK+PROT** for most situations.

e. (Optional) In the Bandwidth Constraint list, select the bandwidth constraint ID to use for the cross-connections based on your site requirements.

5. Click **OK** to create the cross-connections.
**Viewing PPPoE Data for Ethernet Uplinks**

Point to Point Protocol over Ethernet (PPPoE) is a Layer 2 network protocol for encapsulating PPP frames inside Ethernet frames, allowing subscriber sessions to be isolated from one another. PPPoE-based subscribers are identified by the application ID of their uplink Permanent Virtual Channel (PVC).

To support uplink service for PPPoE sessions, the C7 GE-2p plug-in card provides a simple PPPoE Relay function. PPPoE sessions do not terminate on the C7, but instead are passed transparently upstream to an Access Concentrator. The primary role of the PPPoE relay agent is to support split horizon bridging, which prevents subscriber traffic from being bridged to other subscribers.

You can view the following PPPoE data on the GE-2p card:

- **Access Concentrator**: Name, location, and address information about the PPPoE Access Concentrators.
- **Host**: Location, address, and session status information of the PPPoE hosts.
- **Session**: PPPoE session information stored by the GE-2p PPPoE relay agent.
- **Stats**: PPPoE protocol statistics for the GE-2p PPPoE relay agent.
- **AC Stats**: PPPoE protocol statistics reported by each Access Concentrator.

**PPPoE Access Concentrator**

The Access Concentrator is an upstream device that terminates PPPoE connections. The GE-2p card, which serves as a PPPoE relay agent, learns of the location and address of Access Concentrators from the PPPoE discovery packets that it intercepts during the relay process.

The following information displays on the PPPoE Access Concentrator screen:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Location (PLOCN)</td>
<td>Physical location of the PPPoE relay agent (slot address of the GE-2p card).</td>
</tr>
<tr>
<td>MAC Address (MACADDRESS)</td>
<td>MAC Address of the Access Concentrator as learned from the PPPoE Discovery packets.</td>
</tr>
<tr>
<td>Layer 2 Interface AID (L2IFAID)</td>
<td>Layer 2 Interface Access Identifier. The GE-2p port on which the AC was discovered.</td>
</tr>
<tr>
<td>Access Concentrator Name (ACNAME)</td>
<td>The device name advertised by the Access Concentrator in PPPoE Discovery packets.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Name (SVCNAME)</td>
<td>The name of a service advertised by the Access Concentrator in PPPoE Discovery packets.</td>
</tr>
</tbody>
</table>

**PPPoE Host**

The PPPoE host is the device at the customer premises, typically a DSL modem. The PPPoE host terminates the host end of a PPPoE session. The GE-2p card, which serves as the PPPoE relay agent, learns of the location and address of the host from the PPPoE discovery packets that it intercepts during the relay process. The PPPoE relay agent (GE-2p) stores information about PPPoE hosts in its data tables.

The following information displays on the PPPoE Host screen:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC Address (MACADDRESS)</td>
<td>MAC Address of the host as learned from the PPPoE Discovery packets.</td>
</tr>
<tr>
<td>Physical Location (PLOCN)</td>
<td>Physical location of the PPPoE relay agent (GE-2p).</td>
</tr>
<tr>
<td>Layer 2 Interface AID (L2IFAID)</td>
<td>Layer 2 Interface Access Identifier. The port on which the host was discovered or the remote endpoint of the subscriber VC.</td>
</tr>
<tr>
<td>Session Status (SESSION)</td>
<td>Shows whether the host has an active session.</td>
</tr>
</tbody>
</table>

**PPPoE Session**

An active PPPoE session is a session that has successfully completed the discovery phase and has entered the session phase, during which actual data packets pass through the system. The GE-2p card, which serves as the PPPoE relay agent, learns of sessions from the PPPoE discovery packets that it intercepts during the relay process. The PPPoE relay agent (GE-2p) stores information about the sessions in its data tables.

The following information displays on the PPPoE Session screen:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Location (PLOCN)</td>
<td>Physical location of the PPPoE relay agent (slot address of the GE-2p card).</td>
</tr>
<tr>
<td>MAC Address (MACADDRESS)</td>
<td>The MAC Address of the Access Concentrator.</td>
</tr>
<tr>
<td>Host MAC Address (HOSTMAC)</td>
<td>The MAC Address of the host as learned from the PPPoE Discovery packet.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AC Session ID (ACSESS)</td>
<td>The session ID is a 16 bit integer produced by the Access Concentrator during the discovery phase.</td>
</tr>
<tr>
<td>Layer 2 Interface AID (L2IFAID)</td>
<td>Layer 2 Interface Access Identifier. The GE-2p port on which the AC was discovered.</td>
</tr>
<tr>
<td>Access Concentrator Name (ACNAME)</td>
<td>The device name advertised by the Access Concentrator in PPPoE Discovery packets.</td>
</tr>
<tr>
<td>Service Name (SVCNAME)</td>
<td>The service name as requested by the host.</td>
</tr>
<tr>
<td>Session State (STATE)</td>
<td>Session State. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>PADR</strong>: Host has sent PADS</td>
</tr>
<tr>
<td></td>
<td>• <strong>PADS</strong>: AC has sent PADS</td>
</tr>
<tr>
<td></td>
<td>• <strong>DATA</strong>: PRA has installed forwarding in network processor subsystem</td>
</tr>
<tr>
<td></td>
<td><strong>INVALID</strong>: Invalid session state.</td>
</tr>
<tr>
<td>PADR Time Stamp (PADRTS)</td>
<td>Time stamp for last PAD request received from the Access Concentrator.</td>
</tr>
<tr>
<td>PADS Time Stamp (PADSTS)</td>
<td>Time stamp for last PAD session confirmation received from the Access Concentrator.</td>
</tr>
<tr>
<td>Relay Session Identifier (RELAYID)</td>
<td>Relay Session Identifier as detected from a peer PPPoE relay agent. Value shown only if seen in Discovery packets for this session.</td>
</tr>
</tbody>
</table>

### PPPoE Stats

The PPPoE Stats screen shows protocol statistics for the GE-p plug-in card as a whole, or for a particular port on the card. The ports include all of the physical ports and the pseudo port.

The following information displays on the PPPoE Stats screen:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Router AID (RTAID)</td>
<td>Slot address of the GE-2p card (PPPoE relay agent).</td>
</tr>
<tr>
<td>Bad version (BADVER)</td>
<td>Packets with unsupported PPPoE Version field.</td>
</tr>
<tr>
<td>PADI</td>
<td>Total PADI (PPPoE Active Discovery Initiation) packets.</td>
</tr>
<tr>
<td>PADO</td>
<td>Total PADO (PPPoE Active Discovery Offer) packets.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PADR</td>
<td>Total PADR (PPPoE Active Discovery Request) packets.</td>
</tr>
<tr>
<td>PADS</td>
<td>Total PADS (PPPoE Active Discovery Session Confirmation) packets.</td>
</tr>
<tr>
<td>PADT</td>
<td>Total PADT (PPPoE Active Discovery Termination) packets.</td>
</tr>
<tr>
<td>Bad PADI (BADPADI)</td>
<td>Malformed PADI (PPPoE Active Discovery Initiation) packets.</td>
</tr>
<tr>
<td>Bad PADO (BADPADO)</td>
<td>Malformed PADO (PPPoE Active Discovery Offer) packets.</td>
</tr>
<tr>
<td>Bad PADR (BADPADR)</td>
<td>Malformed PADR (PPPoE Active Discovery Request) packets.</td>
</tr>
<tr>
<td>Bad PADS (BADPADS)</td>
<td>Malformed PADS (PPPoE Active Discovery Session Confirmation) packets.</td>
</tr>
<tr>
<td>Bad PADT (BADPADT)</td>
<td>Malformed PADT (PPPoE Active Discovery Termination) packets.</td>
</tr>
<tr>
<td>Initiated Sessions (INITSESS)</td>
<td>Total sessions initiated.</td>
</tr>
<tr>
<td>Created Sessions (CREATESESS)</td>
<td>Total sessions created.</td>
</tr>
<tr>
<td>Active Sessions (ACTIVESESS)</td>
<td>Total sessions currently active.</td>
</tr>
</tbody>
</table>

**PPPoE AC Stats**

The PPPoE AC Stats screen shows protocol statistics sent by each Access Concentrator.

The following information displays on the PPPoE AC Stats screen:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC Address (MACADDRESS)</td>
<td>MAC Address of the Access Concentrator as learned from the PPPoE Discovery packets.</td>
</tr>
<tr>
<td>Router AID (RTRAID)</td>
<td>Slot address of the GE-2p card (PPPoE relay agent).</td>
</tr>
<tr>
<td>PADI</td>
<td>Total PADI (PPPoE Active Discovery Initiation) packets received by AC.</td>
</tr>
<tr>
<td>PADR</td>
<td>Total PADR (PPPoE Active Discovery Request) packets received by AC.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PADO</td>
<td>Total PADO (PPPoE Active Discovery Offer) packets sent by AC.</td>
</tr>
<tr>
<td>PADS</td>
<td>Total PADS (PPPoE Active Discovery Session Confirmation) packets sent by AC.</td>
</tr>
<tr>
<td>Received PADT (RXPADT)</td>
<td>Total PADT (PPPoE Active Discovery Termination) packets sent by AC.</td>
</tr>
<tr>
<td>Transmitted PADT (TXPADT)</td>
<td>Total PADT (PPPoE Active Discovery Termination) packets sent by AC.</td>
</tr>
<tr>
<td>PADI Time Stamp (PADITS)</td>
<td>Timestamp of the last PADI (PPPoE Active Discovery Initiation) packet received by AC. Format mm/dd/yyyy hh:mm:ss.</td>
</tr>
<tr>
<td>PADR Time Stamp (PADRTS)</td>
<td>Timestamp of the last PADR (PPPoE Active Discovery Request) packet received by AC. Format mm/dd/yyyy hh:mm:ss.</td>
</tr>
<tr>
<td>PADO Time Stamp (PADOTS)</td>
<td>Timestamp of the last PADO (PPPoE Active Discovery Offer) packet sent by AC. Format mm/dd/yyyy hh:mm:ss.</td>
</tr>
<tr>
<td>PADS Time Stamp (PADSTS)</td>
<td>Timestamp of the last PADS (PPPoE Active Discovery Session Confirmation) packet sent by AC. Format mm/dd/yyyy hh:mm:ss.</td>
</tr>
<tr>
<td>PADT Sent Time Stamp (PADTSENTTS)</td>
<td>Timestamp of the last PADT (PPPoE Active Discovery Termination) packet sent by AC. Format mm/dd/yyyy hh:mm:ss.</td>
</tr>
<tr>
<td>PADT Received Time Stamp (PADTRCVDTS)</td>
<td>Timestamp of the last PADT (PPPoE Active Discovery Termination) packet received by AC. Format mm/dd/yyyy hh:mm:ss.</td>
</tr>
<tr>
<td>Initiated Sessions (INITSESS)</td>
<td>Total sessions initiated.</td>
</tr>
<tr>
<td>Created Sessions (CREATESESS)</td>
<td>Total sessions created.</td>
</tr>
<tr>
<td>Active Sessions (ACTIVESESS)</td>
<td>Total sessions currently active.</td>
</tr>
</tbody>
</table>
Chapter 6

Quick Internet Service Turn-Up

This chapter provides several "quick turn-up" processes to configure broadband Internet services on the Calix C7. These turn-up processes provide the high-level steps for configuring service rather than the detailed instructions for performing each task. (The detailed provisioning instructions are found elsewhere in this guide).

Because the C7 supports several types of both subscriber access (ADSL and ONT Ethernet) and uplink facilities (Ethernet and ATM) for broadband Internet service applications, this chapter provides quick turn-up processes for each combination of access and uplink type. Experienced iMS users can follow these processes to quickly turn up service according to your specific application requirements.

Processes Covered

This chapter covers the following configuration processes for turning up broadband Internet service:

- Turning up Internet service on ADSL ports using an Ethernet uplink.
- Turning up Internet service on ADSL ports using an ATM uplink.
- Turning up Internet service on ONT Ethernet ports using an Ethernet uplink.
- Turning up Internet service on ONT Ethernet ports using an ATM uplink.
Turning Up ADSL Internet Service (Ethernet Uplink)

This section provides a quick turn-up process for configuring ADSL Internet service with an Ethernet uplink.

Starting point

Before starting the configuration process, check that the following conditions are met:

- Transport is established to all C7 nodes providing ADSL Internet service.
- Remote ADSL service cards are installed and wired.
- The GE-2p uplink card is installed and wired.

Information you need

You need to have the following information on-hand to configure broadband Internet service:

- ATM traffic profile requirements to create custom profiles for subscriber cross-connects.
- ADSL service parameter requirements to create custom ADSL templates.
- VPI and VCI values used by the subscriber ADSL modem.
- At least two IP addresses for the GE-2p uplink card—one IP address for the physical Ethernet uplink interface and one or more IP addresses to define the subscriber subnet(s) for DHCP relay, if applicable (for RBE connections only). All IP addresses must belong to different subnets. IP interfaces are not required for PPPoE uplinks.
- The IP address of the default gateway router (not required for PPPoE uplinks).

Quick Turn-Up Process

The quick turn-up process for ADSL Internet service follows:

To configure profiles and templates

1. Create custom ATM traffic profiles to define the bandwidth attributes for subscriber cross-connects. You can create custom UBR or UBR+ traffic profiles for each different upstream and downstream Internet traffic connection supported in your network. See Creating Custom UBR and UBR+ Traffic Profiles (on page 17) for details.

2. Create ADSL templates to define the different operational settings for ADSL ports in your network. See Creating Custom ADSL Templates (on page 27) for details.
3. Create Subscriber Templates to define your service offerings. Create individual templates for each different ADSL Internet service. See Creating Subscriber Templates (on page 28) for details.

To configure the Ethernet uplink

1. Configure the Ethernet port for uplink service.
   - For details to configure a GE port, see Configuring a Gigabit Ethernet Port (on page 34). If the router does not support automatic detection of transmission settings, set the GE port speed to **1000** and duplex mode to **Full** instead of accepting the default **Automatic** settings.
   - For details to configure an FE port, see Configuring a Fast Ethernet Port (on page 35). If the router does not support automatic detection of transmission settings, set the FE port speed to **10** or **100** and duplex mode to **Full** instead of the accepting default **Automatic** settings.

2. Configure IP interfaces on the GE-2p card. All IP interface addresses must belong to different subnets. See Configuring IP Interfaces (on page 37) for details.
   a. Configure an IP interface on the physical GE or FE uplink port.

   **Note:** If the uplink shall support only PPPoE connections, skip the remaining uplink configuration steps as they are not required for PPPoE relay.

   b. Configure an IP interface on Pseudo Port 1 (PP1) for each RBE host subnet that the GE-2p must support.

3. Configure one or more static IP routes on the GE-2p card to define routes to external networks or subnets.
   a. Create a default route for Internet traffic. This static route defines the network default gateway. Specify a destination address of 0.0.0.0, a netmask of 0.0.0.0, and the IP address of the router connected to the Ethernet uplink as the gateway address. See Configuring Static IP Routes (on page 38) for details.
   b. (Optional) Create additional static IP routes to other external subnets as needed.

4. Configure a DHCP server connection on the GE-2p card to support DHCP relay for subscribers with Routed Bridged Encapsulation (RBE) connections. See Configuring DHCP Server Connections (on page 39) for details.

5. Configure one or more sub interface bindings to establish host subnets for DHCP relay support. A sub interface binding defines the subnet to which DHCP clients (RBE hosts) in the C7 network will belong. See Configuring Sub Interface Bindings (on page 40) for details.

6. (Optional) Configure static IP hosts in the GE-2p routing table. Assign static (“fixed”) IP addresses to enable routing to hosts for which DHCP addressing and/or Address Resolution Protocol (ARP) is not available. See (Optional) Creating Static IP Hosts (on page 42) for details.

   **Note:** Creating static IP hosts is optional. Skip Step 6 if you do not require static hosts.
To configure the subscriber connections

1. Create the subscriber connections for ADSL Internet service. Use the Add Subscriber wizard to apply a Subscriber Template to the ADSL port(s) and to automatically create the cross-connections to the uplink. See Adding New Subscriber Connections (on page 54) for details.

2. Activate the broadband Internet service for delivery by placing the ADSL ports into service. See Placing Subscriber Ports Into Service (on page 58) for details.

Turning Up ADSL Internet Service (ATM Uplink)

This section provides a quick turn-up process for configuring ADSL Internet service with an ATM uplink.

Starting point

Before starting the configuration process, check that the following conditions are met:

- Transport is established to all C7 nodes providing ADSL Internet service.
- Remote ADSL service cards are installed and wired.
- The ATM uplink card is installed and wired.

Information you need

You need to have the following information on-hand to configure broadband Internet service:

- ATM traffic profile requirements to create custom profiles for subscriber cross-connects.
- ADSL service parameter requirements to create custom ADSL templates.
- VPI and VCI values used by the subscriber ADSL modem.

Supported ATM uplink types

Calix C7 ATM uplink types include OCn optical, DS3, IMA, or T1 UNI interfaces using the following plug-in cards:

- OC3-4, OC12-4, OC48-1
- RAP-OC3/12, RAP-OC3/12/48, RAP-OC48
- DS3-12p, DS3-4p
- T1-6 A+T (IMA or UNI mode)
Quick Turn-Up Process

The quick turn-up process for ADSL Internet service follows:

To configure profiles and templates

1. Create custom ATM traffic profiles to define the bandwidth attributes for subscriber cross-connects. You can create custom UBR or UBR+ traffic profiles for each different upstream and downstream Internet traffic connection supported in your network. See Creating Custom UBR and UBR+ Traffic Profiles (on page 17) for details.

2. Create ADSL templates to define the different operational settings for ADSL ports in your network. See Creating Custom ADSL Templates (on page 27) for details.

3. Create Subscriber Templates to define your service offerings. Create individual templates for each different ADSL Internet service. See Creating Subscriber Templates (on page 28) for details.

To configure the ATM uplink

Configure the ATM uplink according to your uplink interface type as follows:

OCn optical uplink

1. Configure the OCn optical port for service.
   - Set the External Interface parameter to Y (Yes).
   - Set the remaining port parameter values to match the settings on the far end.

2. Configure an STS facility on the OCn optical port.
   - Set the STS Mapping parameter to ATMUNI.
   - Set the remaining STS parameter values to match the settings on the far end.

For details to configure an OCn optical uplink, see Configuring an OCn Optical Uplink (on page 45).

DS3 uplink

Configure the DS3 port for uplink service.

- Set the DS3 Interface Type parameter to UNI.
- Set the External Interface parameter to Y (Yes).
- Set the remaining port parameter values to match the settings on the far end.

For details to configure a DS3 uplink, see Configuring a DS3 Uplink (on page 47).
IMA uplink

1. Configure the T1 ports for use in an IMA group.
   - Set the DS1 Type parameter to **DS1** or **T1** as required.
   - Set the following T1 port parameter values: set DS1 Format to **ESF**, DS1 Line Coding to **B8ZS**, DS1 Map to **N/A**.
   - Set the remaining T1 port parameter values to match the settings on the far end.
2. Create an IMA group and add the T1 links to it.
3. Configure the IMA group for service.
   - Set the Mapping parameter to **UNI**.
   - Set the External Interface parameter to **Y** (Yes).
   - Set the remaining parameter values to match the settings on the far end.

For details to configure an IMA uplink, see *Configuring an IMA Uplink* (see "Configuring a DS3 Uplink" on page 47).

T1 UNI uplink

1. Configure the DS1 Type parameter to **DS1** or **T1** as required.
2. Configure the T1 port for service.
   - Set the DS1 Map parameter to **UNI**.
   - Set the External Interface parameter to **Y** (Yes).
   - Set the remaining T1 port parameter values to match the settings on the far end.

For details to configure a T1 UNI uplink, see *Configuring a T1 UNI Uplink* (on page 51).

To configure the subscriber connections

1. Create the subscriber connections for ADSL Internet service. Use the *Add Subscriber* wizard to apply a Subscriber Template to the ADSL port(s) and to automatically create the cross-connections to the uplink. See *Adding New Subscriber Connections* (on page 54) for details.

2. Activate the broadband Internet service for delivery by placing the ADSL ports into service. See *Placing Subscriber Ports Into Service* (on page 58) for details.
Turning Up ONT Internet Service (Ethernet Uplink)

This section provides a quick turn-up process for configuring ONT Internet service over PON with an Ethernet uplink.

Starting point

Before starting the configuration process, check that the following conditions are met:

- Transport is established to all C7 nodes providing Internet service over PON.
- The OLT cards providing the PON interfaces are installed and wired.
- The ONTs at the customer premises are installed, wired, turned up and ranged.
- The GE-2p uplink card is installed and wired.

Information you need

You need to have the following information on-hand to configure broadband Internet service:

- ATM traffic profile requirements to create custom profiles for subscriber cross-connects.
- At least two IP addresses for the GE-2p uplink card—one IP address for the physical Ethernet uplink interface and one or more IP addresses to define the subscriber subnet(s) for DHCP relay, if applicable (for RBE connections only). All IP addresses must belong to different subnets. IP interfaces are not required for PPPoE uplinks.
- The IP address of the default gateway router (not required for PPPoE uplinks).

Quick Turn-Up Process

The quick turn-up process for ONT Internet service follows:

To configure profiles and templates

1. Create custom ATM traffic profiles to define the bandwidth attributes for subscriber cross-connects. You can create custom UBR+ traffic profiles for each different upstream and downstream Internet traffic connection supported in your network. See Creating Custom UBR and UBR+ Traffic Profiles (on page 17) for details.

2. Create Subscriber Templates to define your service offerings. Create individual templates for each different ONT Internet service. See Creating Subscriber Templates (on page 28) for details.
To configure the Ethernet uplink

1. Configure the Ethernet port for uplink service.
   - For details to configure a GE port, see Configuring a Gigabit Ethernet Port (on page 34). If the router does not support automatic detection of transmission settings, set the GE port speed to 1000 and duplex mode to Full instead of accepting the default Automatic settings.
   - For details to configure an FE port, see Configuring a Fast Ethernet Port (on page 35). If the router does not support automatic detection of transmission settings, set the FE port speed to 10 or 100 and duplex mode to Full instead of the accepting default Automatic settings.

2. Configure IP interfaces on the GE-2p card. All IP interface addresses must belong to different subnets. See Configuring IP Interfaces (on page 37) for details.
   a. Configure an IP interface on the physical GE or FE uplink port.
      **Note:** If the uplink shall support only PPPoE connections, skip the remaining uplink configuration steps as they are not required for PPPoE relay.
   b. Configure an IP interface on Pseudo Port 1 (PP1) for each RBE host subnet that the GE-2p must support.

3. Configure one or more static IP routes on the GE-2p card to define routes to external networks or subnets.
   a. Create a default route for Internet traffic. This static route defines the network default gateway. Specify a destination address of 0.0.0.0, a netmask of 0.0.0.0, and the IP address of the router connected to the Ethernet uplink as the gateway address. See Configuring Static IP Routes (on page 38) for details.
   b. (Optional) Create additional static IP routes to other external subnets as needed.

4. Configure a DHCP server connection on the GE-2p card to support DHCP relay for subscribers with Routed Bridged Encapsulation (RBE) connections. See Configuring DHCP Server Connections (on page 39) for details.

5. Configure one or more sub interface bindings to establish host subnets for DHCP relay support. A sub interface binding defines the subnet to which DHCP clients (RBE hosts) in the C7 network will belong. See Configuring Sub Interface Bindings (on page 40) for details.

6. (Optional) Configure static IP hosts in the GE-2p routing table. Assign static (“fixed”) IP addresses to enable routing to hosts for which DHCP addressing and/or Address Resolution Protocol (ARP) is not available. See (Optional) Creating Static IP Hosts (on page 42) for details.

**Note:** Creating static IP hosts is optional. Skip Step 6 if you do not require static hosts.
To configure the subscriber connections

1. Create the subscriber connections for ONT Internet service. Use the *Add Subscriber* wizard to apply a Subscriber Template for ONT data service that automatically creates the cross-connections to the uplink. See *Adding New Subscriber Connections* (on page 54) for details.

2. Activate the broadband Internet service for delivery by placing the ONT Ethernet ports into service. See *Placing Subscriber Ports Into Service* (on page 58) for details.

**Turning Up ONT Internet Service (ATM Uplink)**

This section provides a quick turn-up process for configuring ONT Internet service over PON with an ATM uplink.

**Starting point**

Before starting the configuration process, check that the following conditions are met:

- Transport is established to all C7 nodes providing Internet service over PON.
- The OLT cards providing the PON interfaces are installed and wired.
- The ONTs at the customer premises are installed, wired, turned up and ranged.
- The ATM uplink card is installed and wired.

**Information you need**

You need to have the following information on-hand to configure broadband Internet service:

- ATM traffic profile requirements to create custom profiles for subscriber cross-connects.
- VPI and VCI values to use for the subscriber cross-connections.

**Supported ATM uplink types**

Calix C7 ATM uplink types include OC4n optical, DS3, IMA, or T1 UNI interfaces using the following plug-in cards:

- OC3-4, OC12-4, OC48-1
- RAP-OC3/12, RAP-OC3/12/48, RAP-OC48
- DS3-12p, DS3-4p
- T1-6 A+T (IMA or UNI mode)
Quick Turn-Up Process

The quick turn-up process for ONT Internet service follows:

**To configure profiles and templates**

1. Create custom ATM traffic profiles to define the bandwidth attributes for subscriber cross-connects. You can create custom UBR+ traffic profiles for each different upstream and downstream Internet traffic connection supported in your network. See *Creating Custom UBR and UBR+ Traffic Profiles* (on page 17) for details.

2. Create Subscriber Templates to define your service offerings. Create individual templates for each different ONT Internet service. See *Creating Subscriber Templates* (on page 28) for details.

**To configure the ATM uplink**

Configure the ATM uplink according to your uplink interface type as follows:

**OCn optical uplink**

1. Configure the OCn optical port for service.
   - Set the External Interface parameter to Y (Yes).
   - Set the remaining port parameter values to match the settings on the far end.

2. Configure an STS facility on the OCn optical port.
   - Set the STS Mapping parameter to ATMUNI.
   - Set the remaining STS parameter values to match the settings on the far end.

For details to configure an OCn optical uplink, see *Configuring an OCn Optical Uplink* (on page 45).

**DS3 uplink**

Configure the DS3 port for uplink service.

- Set the DS3 Interface Type parameter to UNI.
- Set the External Interface parameter to Y (Yes).
- Set the remaining port parameter values to match the settings on the far end.

For details to configure a DS3 uplink, see *Configuring a DS3 Uplink* (on page 47).

**IMA uplink**

1. Configure the T1 ports for use in an IMA group.
   - DS1 Type parameter to DS1 or T1 as required.
   - Set the following T1 port parameter values: set DS1 Format to ESF, DS1 Line Coding to B8ZS, DS1 Map to N/A.
Set the remaining T1 port parameter values to match the settings on the far end.

2. Create an IMA group and add the T1 links to it.
3. Configure the IMA group for service.
   - Set the Mapping parameter to UNI.
   - Set the External Interface parameter to Y (Yes).
   - Set the remaining parameter values to match the settings on the far end.

For details to configure an IMA uplink, see Configuring an IMA Uplink (see "Configuring a DS3 Uplink" on page 47).

**T1 UNI uplink**

1. DS1 Type parameter to DS1 or T1 as required.
2. Configure the T1 port for service.
   - Set the DS1 Map parameter to UNI.
   - Set the External Interface parameter to Y (Yes).
   - Set the remaining T1 port parameter values to match the settings on the far end.

For details to configure a T1 UNI uplink, see Configuring a T1 UNI Uplink (on page 51).

**To configure the subscriber connections**

1. Create the subscriber connections for ONT Internet service. Use the Add Subscriber wizard to apply a Subscriber Template for ONT data service and to automatically create the cross-connections to the uplink. See Adding New Subscriber Connections (on page 54) for details.

2. Activate the broadband Internet service for delivery by placing the ONT Ethernet ports into service. See Placing Subscriber Ports Into Service (on page 58) for details.